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1  Overview
_

Introduction

This handbook describes the basic features of the Banner System. Learning to use these
features is the foundation for using Banner at your institution.

Sample forms in this handbook were created in a Windows environment. Your forms may

have subtle differences if you use a different environment; however, most functionality is
the same regardless of your environment.

Starting Banner

The steps for accessing Banner depend on your hardware, software, and network
configuration. Because there are many ways to access Banner, this section does not give
specific steps for launching your system. Instead, this section describes the common
requirements for getting into Banner. Your institution’s implementation may be different.

To help ensure that only authorized users access Banner, you must log in with a username

(user ID) and a password. Your institution may have additional network and operating

system login and security procedures.

These are the common steps for starting Banner.

1. Use your institution’s procedures to start your workstation.

2. Launch your web browser and enter the URL used to access Banner.

3. Enter your username, password, and database (depending on your environment) at the
logon prompts. If you enter a wrong username or password, you are prompted to

reenter both. (Your institution determines the number of times you can try to log on.)

Once you complete these steps, the Banner main menu appears:
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g& Oracle Developer Forms Runtime - Web =10 ll

File Edit Cptions Block Item Record Cuery Tools Help
(BB AAERE %% BEX A S BE 'S

w3 General Menu J 8.0 - Monday June O - Last login Wednesday March

GoTo...| [*] welcome, ORRQUL Products: [~] Menu | site Wap | Help Center

I:IMV Banner My Links
ABanner
[ student [*STUDENT] Change Banner Password

(1 Advancement [*ALUMMNI]
CIFinance [*FINANCE]
[JHuman Resources [*HRS]
[JFinancial Aid [*RESOURCE] Personal Link 2
(O General [*GENERAL]

Jpocument Management Suite [*BDMS]

Check Banner Message

Personal Link 1

Personal Link 3
Personal Link 4
Personal Link &

Personal Link 6

My Institution

SUNGARD HIGHER EDUCATION

Banner Broadcast Messages

Enter the object name; Press LIST for listing |
Record: 111 || N | =08C=

Select the folder next to a menu to expand the menu so you can see the objects it contains.
Select the folder again to collapse the menu.

In this figure the Products Menu is expanded. Your institution may be using another menu
as the default expanded menu on the main menu. Individual users can override the
institution default and establish a personal default. See the Banner General Technical
Reference Manual for instructions on setting the institution default. See “To Specify the
Default Expanded Menu” in chapter 5 for instructions on setting a personal default.

The main menu is the starting point for navigating through Banner. You can use the menu
structure to access a form, job, menu, or QuickFlow. Or you can use Direct Access to go to
a specific form if you know the form’s name. Navigation is described in chapter 3, Getting
Around Banner.

Using the Mouse and Keyboard

You can perform most Banner functions with either a mouse or keyboard. For example,
you can save information by clicking a button on the toolbar, selecting an item from a pull-
down menu, or pressing equivalent keystrokes. Because you can choose from several
methods, this handbook does not usually tell you specifically how to perform a function.
Instead, the instructions say to “select” the function. Mouse and keyboard instructions are
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given only if they are distinctly different from each other. Two symbols appear throughout
this handbook to indicate the different sets of instructions:

% Mouse instructions

& Keyboard instructions

Keyboard Equivalents

Specific keystrokes for a function depend on your environment. For example, Enter Query
might be F7 in one environment and F11 in another. Because keystrokes vary from one
environment to another, they are not described in this manual. Show Keys is a valuable
tool that helps you use the keyboard. This function lists the keyboard equivalents available
in your environment for the current form, window, and field.

Function ey fest]

Clear Field Cirl+L

Display Errar Shift+F 1 I3 Show Keys lists the

Downh Diown I keyboard equivalents that
Down Cirl+L B are available in your

Enter Query F7 environment for the current
Execute Query Fa form, window, and field.

Exit Cirl+Q =

A0 s | r

To display keyboard equivalents:
2 =
Select Help>Show Keys Use the keystrokes for the Show Keys function.
(Check with your data center personnel for these
keystrokes.)

Quick Reference Chart

You can complete the chart on the next page and use it as a quick reference for keyboard
equivalents at your institution. First use Show Keys to determine the equivalent for each
option on the Banner pull-down menus. Then record each equivalent on the chart. You can
post the chart for easy reference.
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File Edit Options Block Iltem Record Query Tools Help

Direct Access Cut Varies by Previous Previous Previous Enter Document Online Help
form Management
Suite
Object Copy Next Next Next Execute Workflow Dynamic
Search Help Query
QuickFlow Paste Clear Clear Scroll Up Last Criteria Dynamic
Help Edit
Select Edit Duplicate Scroll Down Cancel Help (tem
Properties)
Rollback Clear Count Hits Show Keys
Save Remove Fetch Next List
Set
Refresh Insert Display Error
Print Duplicate Display ID
Image
Exit Lock Calendar
Exit Calculator
QuickFlow
Exit Banner Extract Data
with Key
Return to Extract Data
Menu No Key
Preferences Technical
Support
About Banner
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Naming Conventions for Banner Objects

The unigue seven- or eight-character names of Banner objects—forms, reports, jobs, and
tables—are assigned according to a set of conventions. Each name is built from the same

four components:
» System identifier (one or two characters). See “System Identifiers,” below.

» Module identifier (one character). See “Module Identifier” on page 1-6.

» Object type code (one character). See “Object Type Codes” on page 1-10.

 Unique identifier (four characters).

A few examples of Banner object names are shown in the table below.

Item Name System Module Object type Unique identifier
SPAIDEN S P A IDEN
Student Person Application Identification
GJRRPTS G J R RPTS
General Job Submission Report Report and Parameter
Information
GTVZIPC G T \% ZIPC
General Validation form/  Validation form/  Zip/Postal Code
table table
s Note
For information about table and column naming conventions, refer to the
General Technical Reference Manual. [

System ldentifiers

The first component of a Banner object name is a one- or two-character system identifier.

This code identifies the primary system owning the form, report, job, or table.

s Note
In most case (but not always) the system identifier is the same as the
System Indicator in the GTVSYSI table. |

5 Note
If the identifier code is one character long, the form, report, job, or table
name is seven characters long. If the identifier is two characters long, the
name is eight characters long. m

June 2008 Banner General 8.0
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Identifier System

A Banner Advancement

E Banner Document Management Suite

F Banner Finance

G Banner General

IC Banner Integration Components

I Information Access (Kiosk)

MC Reserved for Mod Center

N Banner Position Control

P Banner HR/Payroll/Personnel

R Banner Financial Aid

S Banner Student

T Banner Accounts Receivable

VR Banner Voice Response

W Reserved for client applications that co-exist with Banner
XP Windstar International Tax Navigator Interface for Banner
Y Reserved for client applications that co-exist with Banner
z Reserved for client applications that co-exist with Banner

Module Identifier

The second component in a Banner object name (typically position 2) identifies the
module of the form, report, job, or table.

Module
System Identifier  Code Module
Advancement A A Membership
D Designation
E Event Management
F Campaign
G Pledge and Gift/Pledge Payment
L Label
M Prospect Management
0] Organization
P Constituent/Person
S Solicitor Organization
T Validation form/table
U Utility
\Y Reserved-Can. Solution Citr.
|
1-6 Banner General 8.0 June 2008
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System

Identifier

Module
Code

Module

BDMS E

Finance F

General G

Information Access/ |
Kiosk

Integration Components IC

Position Control N

June 2008

X -

X<CHuwxxUTOZ—OTMmO®>

X< CHwWUTOr<«m

Py O]

Expected Matching Gift

Validation form/table
BDMS

Accounts Payable

Budget Development

Cost Accounting

Electronic Data Interchange
Fixed Assets

General Ledger

Investment Management
Endowment Management
Operations
Purchasing/Procurement
Research Accounting
Stores Inventory

Validation form/table
Utility

Reserved-Can. Solution Citr.
Archive/Purge

Event Management

Job Submission

Letter Generation

Overall

Purge

Security

Validation form/table
Utility

Reserved-Can. Solution Ctr.
Cross product

General
Financial Aid
Student

General/Overall
Application
Banner General 8.0
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Module

0O
o
o
o

Module

Budget

COBRA
Benefit/Deductions
Employee

Time Reporting/History
Overall

General Person
Electronic Approvals
Security

Validation/rule table
Utility

Reserved-Can. Solution Ctr.
Tax Administration

System Identifier

X< CHWXOTOIMUOW

Human Resources P Application

Budget

COBRA
Benefit/Deductions
Employee

Time Reporting/History
Overall

General Person
Electronic Approvals
Security

Validation/rule table
Utility

Reserved-Can. Solution Ctr.
Tax Administration

X< C-HwXxovOoOImMOoOO®W>»

Financial Aid R Budgeting

Record Creation

Electronic Data Exchange
Funds Management

History and Transcripts
Student Employment
Logging

Need Analysis

Common Functions
Packaging & Disbursements

Requirements Tracking

T 0oOozZzr<eITnnmOm®
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System

Identifier

Module
Code

Module

Student

Accounts Receivable

\Voice Response

Note: The codes listed above apply to Voice Response packages. Voice Response forms are

T

VR

<CHLwWITmUTOZIrX—IOmMmMmMO?D> <CcCc-H®w®”W

< C-Huwxmomm

I ®

wn

Student System Shared Data
Validation form/table

Utility

Reserved-Can. Solution Ctr.

Admissions

Catalog

Support Services
Registration/Fee Assessment
General Student
Grades/Academic History
Faculty Load
Reserved-Intntl. UK
Location Management
CAPP

Overall

Person

Recruiting

Schedule

Validation form/table
Utility

Reserved-Can. Solution Citr.

Finance Accounts Receivable
General Accounts Receivable
Overall

Research Accounting

Student Accounts Receivable
Validation form/table

Utility

Reserved-Can. Solution Ctr.

General

Header (Overall)
Financial Aid
Student

found in the General product and begin with the letters GOR.

June 2008
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Module

System Identifier  Code Module
Windstar International XP D Download
Tax Navigator Interface E Extract
for Banner
All systems any w Reserved for client forms or modules used
within a Banner application
Y Reserved for client forms or modules used
within a Banner application
Z Reserved for client forms or modules used

Object Type Codes

within a Banner application

The third component of a Banner object name (typically position 3) identifies the type of

form, report, job, or table.

System Identifier

Object
Type
Code

Description

Advancement A

Finance F

BDMS E

1-10 Banner General 8.0
Banner Getting Started Guide
Overview

< <L -H>TWUV—0OW?>

< KTTTIHTOZ— >

>

Application form
Base table
Called/list form
Inquiry form
Process/report
Repeating rules table
Temporary table

Validation form
View

Application form
Base table

Inquiry form
Maintenance form
Query form

Rule table
Repeating table
Report/process

Validation form/table
View

Application form
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System Identifier

Object

Type
Code

Description

General G

Information Access/ |
Kiosk

Integration Components IC

Position Control N

Human Resources p

June 2008

<L -H4 T OO0—TmW >

)

Py

< TVTXVDOWVTVT—WW >

< VXVXUVWTVT— W >

Validation form/table

Application form

Base table
Batch COBOL process

Inquiry form
Online COBOL process
Query form

Rule table/form
Repeating table
Report/process

General maintenance
Temporary table

Validation form/table
View

Report/process

Report/process

Application form

Base table
Batch COBOL process

Inquiry form
Process

Rule table
Repeating table
Report/process

Validation form/table

Application form

Base table

Batch COBOL process
Inquiry form

Process

Rule table

Repeating table
Report/process
Validation form/table

Banner General 8.0
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System

Identifier

Object

Type
Code

Description

Financial Aid

Student

Accounts Receivable

\oice Response

Windstar International

Tax Navigator Interface

for Banner
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<<K<-HXVTXWVWXWTWTVT— WP

<KTVTXVTUVTLOHLTUV— WP

<TOT— >

A

Application form
Base table
Inquiry form
Process/report

Rule table
Repeating rules table
Report

Temporary table

Validation form/table
View

Application form
Base table
Inquiry form
Process

Query form

Rule table
Repeating table
Report/process

Validation form/table
View

Application form
Inquiry form

Process

Query form

Report

Validation form/table

Database package

Report/process
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. All About Forms

What Is a Form?

A form is an online document where you can enter and look up information in your
database. A form visually organizes information so it is easier to enter and read. A Banner

form is similar to a paper form, except information is entered once and then used by other
forms, reports, and jobs.

Forms can include windows, window panes, dialog boxes, and alert boxes.

Windows

A window is a framed portion of a form. Just as some paper forms have multiple pages,
some Banner forms have multiple windows. The first window in a form is called the main
window and is identified by the form name. All other windows in the form have their own
unique names.

This form has three [% Oracle Developer Forms Runtime - Weh =l
- . Eile Edit Options Block Item Record Query Tools Window Help
open windows: e —
BOE RAEBE TP BEH @B EEI T &S G @X
73 Event Function GEAFUNC 7.1 (s4b70)
main window —_ : i
Event: ADODS ~ wiellingten Advantage Wwinners System:  student
Function: >
Function: AFSCMEORIE | ¥ AFSCME Mew Employee Orientation =
Type: ORIE * Orientation
‘mRevenue GEAFUNC 7.1 ufs«\h?l:w;u- .
Code Budget Amount Actual Amount Difference Revenue Date
-

/AL Alumni Relations Operating 10.00 10.00 0.00 13-APR-2004 b

Revenue window ——

s s s s s s s s
Code Budget Amount Actual Amount Difference Expense Date
. /= = .
Expenses window B Awards 10.00 10.00 0.00 13-APR-2004 =

The Expenses window is the
active window, indicated by
the highlighted title bar.

Totals: 10.000 10.00 .00
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More than one window can be open at the same time. The only limits are determined by
the amount of memory installed on your system. Not all windows are the same size, so you
might see parts of more than one window at the same time.

You can move a window by dragging its title bar to a new location. (You cannot move the
title bar above the screen.) Your environment may let you resize and move windows in
other ways. Refer to the documentation for your environment.

/N Warning
Banner windows do not use the close button ([x]) in the upper right corner.
Choosing that button will close the form. [

Window Panes

A window pane is an area within a window that has more fields than can appear at one
time.

[& Diacle Developer Forms Runtime - Web =154
File Edit Options Block Item Record Query Tools Window Help

B @ EEEE W E R N = N

Th . . d Building Room Campus Mon Tue Wed Thu Fri Sat Sun Subject Course CRN Cross List Function
IS IS a wihdow — —~4 [~ &
I N JO00000 E I e -
( 1 1 Jgeesezees [ ][ ] CL 1 0O ]
0 0 O 0 oo @
O o @ O B O [ ] [ ] [ ]
HE B E B B B @ R [ ] ]
[ ] oo o oo oo [ ] [ ] ]
[ ] b o oo oo o ] [ ] [ ]
] B B O B B B O ] ] |
[] @ @ o B @ o @ [ ] [ ] ]
[ ] B o o O B O [ ] [ ] [ ]
] B B B B B B @ R [ ] ]
[ ] oo o oo oo [ ] [ ] ]
00 &0 0 Z O O ] [ ] [ ]
HE B E B 8@ @ N ] ] =
A horizonal scroll bar always
appears under a window pane. 2 ' :
Query Term:

Enter a query; press F8 to execute, Cirl+Q to cancel, |
Recard: 1/1 | | Enterqu. | Listofvalu.. | | =0sC-

You can use the horizontal scroll bar at the bottom of a window pane to see the remaining
fields in the pane. You cannot see all fields at one time.

2-2 Banner General 8.0 June 2008
Banner Getting Started Guide
All About Forms




To scroll through the fields in a window pane:

D =

Click and drag the scroll box right or Select the Next Item function (to move
left. to the right) or the Previous Item
function (to move to the left).

OR

. . Note: The cursor skips display-only
Click the arrow at either end of the fields, moving only to enterable fields.
scroll bar.

Dialog Boxes

A dialog box is a window that appears when you must choose from two or more
responses.

® Do you want to save the changes you have made?

This dialog box has three
possible responses.
( Yes H Mo )( Cancel )

You must acknowledge a dialog box before you can do anything else on the form.

To acknowledge a dialog box:

S =

) 1. Select the Next Item function to
Click the button you want. move to the button you want.

2. Press Enter.

Alert Boxes

June 2008

An alert box is a window that notifies you of a condition that may impact data. You can
choose to receive extra alerts when accessing 1Ds of deceased people, or for IDs that are
confidential in nature. Refer to chapter 5 for information about setting up extra
confidential and deceased notifications.

For example, this alert box may appear if you try to enter information for a deceased
person:
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f Warning: This person is deceased.

An alert box always has one response.

You must acknowledge an alert box before you can do anything else on the form.

To acknowledge an alert box:

D

=

Click the OK button. Press Enter.

Types of Forms

Eight types of forms are used throughout Banner:

Main menu

Application
forms

Validation
forms

Rule forms

Control forms

Query forms
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Use this form to navigate through Banner. It provides an
overview of the menus, forms, jobs, and QuickFlows in the
system.

Use these forms to enter, update, and query information. This
is the most common type of form.

Use these forms to define the values that can be entered in
specific fields on application forms. These values are used
throughout Banner. When you look up a code or select the List
function, these values appear in the List of Values window.

Use these forms to define the calculations and parameters that
impact processing on other forms, reports, and jobs.

Use these forms to define the processing rules for application
and validation forms at the system level.

Use these forms to look up existing information, often
returning information to the calling form. You must access
these forms from another form. You cannot access them
directly from the main menu, with Direct Access, or with
Object Search.
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Inquiry forms  Use these forms to look up existing information, often
returning information to the calling form. You can access these
forms from the main menu, from another form, with Direct
Access, or with Object Search.

Wizard forms  Use these forms to give step-by-step instructions for
completing an application.

Validation, rule, and control forms are used to tailor Banner to your institution’s
procedural requirements when Banner is implemented. You can make revisions with these
forms any time, if your security level permits.

b Note
Only Banner General uses all of the different form types. Most Banner
products use only five or six. m

Main Menu

File Edit ©ptions Block Item Record Query Tools Help

e BIREREERE %% & Al (BB S 4 H@ X
" General Menu GUAGMHNU - Wednesday July 05, 2006
Co To... B Welcome, JPIERSOL Products: B Menu | Site Map | Help Center
CO||apSGd — My Banner My Links
‘ABanner
1 student [*STUDENT] Change Banner Password
[ advancement [*ALUMNI]
Check Banner Message
expanded OFinance [*FINANCE] .,
W
menu Z1Human Resources [*HRS] =
[JFinancial Aid [*RESOURGCE] Zip Code Form
Currently T g 1l personal Link 3
selected menu is IBanner XtenderSolutions System Menu [*BXS]
hlghllghted Personal Link 4

Personal Link 5

Personal Link &

Iy Institution

SUNGARD HIGHER EDUCATION

Banner Broadcast Messages
01-MAY-2006 Test message to compare to system test,

Prass ENTER to start selection or expand/collapse menu.

The main menu provides access to the menus, forms, jobs, and QuickFlows in Banner, and
is used to navigate through Banner. Refer to chapter 3, “Getting Around Banner,” for
instructions about using the main menu to navigate.
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The main menu displays the Banner products in a familiar Windows-style hierarchical
folder structure. Standard menus are delivered with Banner, but your institution can
reorganize and add menus to meet your specific needs.

Using the Banner Menu Folders

The main menu provides many options for navigating Banner, as well as a place to create
your own custom menus and links for frequently accessed forms, processes, and external
web sites. These features are described briefly here, and in more detail in chapter 3,
Getting Around Banner.

The large pane of the main menu displays two menus:

* My Banner. This menu contains the menus, forms, jobs, and QuickFlows most
important in the workday of the individual user. This menu is tied to a user’s Oracle
user ID.

* Products Menu. This menu organizes menus, forms, jobs, and QuickFlows by the
following Banner products: Student, Advancement, Finance, Human Resources,
Financial Aid, General, and Banner Document Management Suite.

The main menu is delivered with the Products Menu expanded. During installation, your
system administrator can establish another menu as the default expanded menu. Individual
users can override the institution default and establish a personal default for the menu that
is expanded on the main menu. See the Banner General Technical Reference Manual for
instructions on setting the institution default. See “To Specify the Default Expanded
Menu” in chapter 5 for instructions on setting a personal default.

Customizing Menus

You can use the following forms to customize menus for your entire institution or
individual users:

Menu Maintenance Lets you create custom menus for your institution. See
Form (GUTGMNU) “Customizing Menus” in chapter 5.

My Banner Lets you create a My Banner for an individual user. See
Maintenance Form "My Banner" in chapter 5.
(GUAPMNU)
My Banner Copy Form  Lets you copy a My Banner from one user to other users.
(GUTPMNU) See "My Banner" in chapter 5.
|
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Application Forms

Application forms are used to enter, update, and query information in Banner. This is the
most common type of form.

& 0racle Developer Forms Runtime - Weh 5 =]
Eile Edit Options Block Item Record Query Tools Window Help
Letter: |ADM_APPL_ACKN [+ admissions application Ackn
Paragraph Description Comment Sequence
[Table for Recruiting Letter [Table to Indent Institution Name and Signature Variable E -
[mEwPacE [Hew page for letter [start cach letter at new page [
[HEADDTE [Letter Date [Prints current date on left side of page [ 4
[Frmabor | [Formal Hame, address & sal [Prints the formal name with prefix and suffiz, full address and salutation [
[aDmackL | [admissions application ackl [admissions application Acknowledgement, including missing Checklist Items, if aCny [ e
[s1en [signature block [rints Sincerely, name, and ttle for initials used with letter [
[EmcL [Enclosures Paragragh [ [
Paragraph Code; press LIST for codes, COUNT HITS Paragraph, DUPITEM Letter. |
_Recaord: 117 [ | Listofvalu.. | | <05C=

The Letter Process Form (GUALETR) is an example of an application form.
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Validation Forms

Validation forms are used to define the values that can be entered in specific fields on
application forms. These values make up a field’s List of Values (LOV).

Banner uses LOVs to validate many fields. When the cursor is in a field that must be
validated, List of Values appears in the status line, indicating that the entry must come
from the LOV. If you try to enter a value that isn’t in the LOV, an auto hint message
appears. See "Entering Information Into Validated Fields" in chapter 3 for more
information.

Most validation forms are completed when Banner is implemented. If your security level
permits, you can use a validation form to enter new values or update existing ones.
Remember, you can only change values with a validation form, not through an LOV
window.

[&% Oracle Developer Forms Runtime - Web

Eile Edit Qptions Block Itern Record Query Tools wWindow Help

BEEE %% E QIS EE TGS D]

Validation GTVZIPC 7

IIP or State or
Postal Code City County  Province MNation Activity Date
K] &) Ed)

(00503} [agiltia Test [ [pr 18-NOY-2004 2
[a0a02 [saint Thamas [ fer 7 [ [sewovzoos |

00983 Caralina e | 03-MAR-2004

01040 Holyoks test A 17-NOY-2004

01063 Morthampton MA 17-NOV-2004

01247 orth Adams A 05-MAY-2004

o131 [Greentield [ [ma ] 03-MAR-Z004

21440 [gardner [ Wi, [ [oa-mar-zoas

01610 worcester e | 03-MAR-2004

01923 Danvers Ma 03-MAR-2004

02116 Boston MA 10-NOV-2004

02138 Cambridge A 03-MAR-2004 Wl
oz130 [cambridge [ [ma ] 03-MAR-2004

[az154 [waitham [ Wi, [ [oa-mar-zoas

02180 Stoneham e | 27-1UL-2004

02161 Wellesley Ma 03-MAR-2004

02186 Milton Ma 03-MAR-2004

02720 Fall River A 03-MAR-2004

[az7az [morth Dartmoutn [ [ma ] 13- MAR-2004

az7se [martan [ ma [ [oa-Mar-zoos |

ozsss [warwick [ [ ] 03-MAR-2004

‘nglz |meden:e | ’r 03-MAR-2004 -

Zip Code, enter a valid Zip Code | ]

The ZIP/Postal Code Validation Form (GTVZIPC) is an example of a validation form.
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Rule Forms

Rule forms are used to define the calculations and parameters that impact processing on
other forms, reports, and jobs. These forms let you tailor Banner to your institution’s
procedural requirements. You can enter new rules or revise existing ones if your security
level permits.

&2 Oracle Developer Forms Runtime - ‘Web 3] x

File Edit Options Block Item Record Quer ools Window Help

DEREAEE W WIE I &I EE EGE @

Object: [RECR_MAJR [~]
Description: [T AEN
** Press MEXT BLOCK to edit Object Rules, CLEAR BLOCK to delete Object **
Rules
e Data Element Operator Yalue bl AND f OR
=
[ -| [sRERECR_MAIR_CODE [= | [wrecr_majr [ ] | -] &
\ 2 | | 5 | \ =) |
\ || | 2 | \ 2 5|
| A A il
-l ) 3 |
g 2 2 2 |
z| T 7| | |
\ |{ | 5 | \ =) |
\ || | 2 | \ 2 5|
| A A il
| 2 2 |
g 2 2 2l
& [ 5 I B I

OmectDes;riptinn;

The Object Definition Rules Form (GLROBJT) is an example of a rule form.
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Control Forms

Control forms are used to define the processing rules for application and validation forms
at the system level. You can enter new controls or revise existing ones if your security
level permits.

[ Oracle Developer Forms Huntime - Web —lojx|

File Edit Options Block Item Record Query Tools Window Help

Name: Z1P/Postal Code r

Length:
Address: Systermns & Computer Technology
Four Country Wiew Road Base Currency: [uso ™ [=] united States Dallar
Great Valley Corporate Center
Malvern [pa  [1s355 ma;:]";:'l";ﬂ_:'"":?” []
Nation: 157 Eumted States of America
Century Pivot: ,E
Phone: [z15  [eazseso[ Default Date Format: ® MDY
C DMY
Operating/System: UMX - CYMD
Installation Type:
Instance Name: s4b70 g:;;‘i:‘;’:dri?::;:s: ¥ Online Matching Process Enabled
[ Workflow Enabled
[7'SQL Trace Enabled
Activity Date: R [ Messaging Enabled

Installation Information

Release Date Release Date
v advancement 7.0 12-AUG-2004 W Finance 7.0 25-AUG-2004
[ Accounts Receivable 7.0 25-AUG-2004 ¥ Human Resources 7.0 12-AUG-2004
¥ Financial Aid 7.0 31-AUG-2004 ¥ Position Control 7.0 12-AUG-2004
7 Other Financial Aid W Student [0 [r-avc-z00a

GEMERAL [2.0 [10-AuUG-2004

The Installation Control Form (GUAINST) is an example of a control form.
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Query Forms

Query forms are used to look up existing information, often returning information to the
calling form. You must access a query form from another form. You cannot access it
directly from the main menu, with Direct Access, or with Object Search.

Start End
Term Building Room Campus Status Gender Date Date D Last Name First Name
[~ (] ¢ [ = =
\ | \ I E B \ | | =
\ | \ L] O 0O \ \ | |
\ | \ L] O O \ \ | |
\ | \ L] O O \ \ | |
\ | \ L] O O°f \ \ | |
\ | \ L1 00 O°f \ \ | |
\ | \ L1 O O°f \ \ | |
\ | \ L] O O°f \ \ | |
\ | \ L1 O O°f \ \ | |
\ | \ L] O 0O \ \ | |
\ | \ L] O O \ \ | |
\ | \ L] O O \ \ | |
\ | \ L] O O°f \ \ | |
\ | \ L1 00 O°f \ \ | |
\ | \ L1 O O°f \ \ | |
\ | \ L1 O O°f \ \ | |
\ | \ L1 O 0O°f \ \ | |
\ | \ C] O O \ \ | | 5

Enter a query, press F8 to execute, Cirl+Q to cancel | ]

The Dorm Room Query Form (SLARUSE) is an example of a query form.
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Inquiry Forms

Inquiry forms are used to look up existing information, often returning information to the
calling form. You can access an inquiry form from the main menu, from another form,
with Direct Access, or with Object Search.

Dracle Developer Forms Runtime - Web

File Edit Options Block [tem Record Query Tools Window Help

B ERAEEE W@
; D 7

nce Ingquir \TTD 7
Event: \ EH System:
Function: E‘ Fee Status: E RSYP: B Menu: E‘
Guest Indicator: - Has Guest Invitee/Guest Indicator: y;vitee Attended Indicator: - pended
' Has No Guest  Guest ' Did Not Attend Count
® No Guest Criteria ® Both ® No Attendance Criteria
1D Name Function RSYP Fee Status Code Tickets Guest Invitee/Guest Attendance
o [ o =
[ ] O [ O
[] o [ o
| | | | | M = 0 o
| | | l | [ e § =
O O
[ o [ o
[ ] O [ O
[] o [ o
| | | | | M = 0 o
| | | l | e § =
O O
[ o [ o
[ ] O [ O
[] o [ o =]

Event; press COUNT QUERY HITS for valid events.

The Function Attendance Inquiry Form (GEIATTD) is an example of an inquiry form.
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Wizard Forms

Wizard forms are used to give step-by-step instructions for completing an application.

i Diacle Developer Forms Runtime - Web -0l x

File Edit Options Block Item Record Query Tools Window Help

BRI RAAEE 9% B @ B EE Tl & @0 X

113

Add-In Code: |BUDGET [~ Spreadsheet Budgeting
Wizard Name: |UPLOAD [~ Upload Wizard

Step Name: f_UPLOAD_E\OOK Activity Date: |27-A4UG-1399 User ID: |BASELINE 1=
Step Type Code: |‘WKSHEET F Open Warksheets Step Type “;?
Property Code Required Indicator Value Activity Date User ID
=] -

CAPTION ’? ‘Select the worksheet(s). 16-SEP-1999 BASELINE i.
MULTISELECT ’T ‘TRUE 27-AUG-1999 BASELINE
PICTURE M 'WIZARD_EXCEL 31-AUG-1999 BASELINE
REQUIRED i TRUE 27-AUG-1999  |BASELINE
SELECTIONPROC Y_ BANINST1.FBKD3SS.P_SELECTION_UPLOAI 27-AUG-1999 BASELINE
STORINGPROC A

BANINST1.FBKD3SS.P_STORING_UPLOAD_ 27-AUG-1999  [BASELINE

S

]

[ J_ |

] U (I N

Step Narme =

The Wizard Step Setup Application Form (GOADSTE) is an example of a wizard form.
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Parts of a Form

The following figure shows a sample form. Each part of the form is described on the
following pages.

& Oracle Developer Forms Runtime - Web - |o)x

menu bar

Eile Edit Options Block Item Record Query Tools Window Help

toolbar

title bar

key block J

Parameter Set: E[

Printer Control

Printer: Eﬁ Special Print: Lines: Submit Time:

Parameter Values

Number Parameters Values

other blocks . i = 2
,_
,7
,_
L] |
L] ] I
L] |
L]0 | 5

auto hint — | Submission
\ [ Save Parameter Set as Name: Description: < Hold ® Submit
. ; Process Name, press SEARCH for valid processes |
status line — Rrecors 111 | | | <05Cs J
Menu Bar

The Banner menu bar, located at the top of every form, contains pull-down menus.
File Edit Options Block Item Record Query Tools Help

You can access an option in a pull-down menu at any time, except when you are in a
dialog box, alert box, or List of Values (LOV). (You must respond to these windows
before you can access a pull-down menu.)
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To access an option in the menu bar:

D

=

1. Click the desired pull-down menu
name. Menu items appear.
2. Click the desired menu item.

Note: If a pull-down menu item is
dimmed, that menu item is currently
disabled and cannot be accessed.

File Menu

1.

Press the Alt key. The cursor
moves to the menu bar.

Use the right and left arrow keys to
highlight the desired pull-down
menu name. Then press Enter.

OR

Press the underlined letter for the
desired pull-down menu name.

Use the up and down arrow keys to
highlight the desired menu item.
Then press Enter.

OR

Press the underlined letter for the
desired menu item.

Note: If the Options menu contains
multiple menu items that begin with the
same letter, you must use the up and
down arrow keys to select the desired
menu item.

This pull-down menu contains standard Banner and Oracle functions. The bottom of the
menu lists the last forms (up to ten) you accessed in this session. You can select any form

in this list to re-access it.

Some of the menu items let you call another form, job, or QuickFlow. When you exit the
called object, you return to the object you were previously using.

Direct Access Displays the Direct Access Form (GUAPARM), which is used

to access a form by its name. See "Direct Access" in chapter 3.

Object Search Displays the Object Search Form (GUIOBJS), which is used
to search for a menu, form, job, or QuickFlow with part of the
name, description, or type. See "Object Search” in chapter 3.
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QuickFlow

Select

Rollback

Save
Refresh

Print

Exit

Exit QuickFlow

Exit Banner

Return to Menu

Preferences

List of recently
accessed forms
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Displays the QuickFlow Form (GUAQFLW), which is used to
access a QuickFlow. See "QuickFlow™ in chapter 3.

Returns you to the calling form and enters the selected value
into the field that called the form.

Application and inquiry forms
Clears all information (except key information) and returns
you to the first enterable field in the key block.

Validation forms
Returns you to the first enterable field on the form.

Query forms
Returns you to the first enterable field on the calling form.

Saves all changes entered since the last time you saved.
Clears the message line.

Prints the current window with the date and time in the title
bar.

Forms and windows
Exits you from the form or window.

Main menu
Exits you from Banner.

Query mode
Cancels the query and takes the form out of query mode.

Exits you from a QuickFlow.

If Banner Document Management Suite is installed, displays a
list of documents that match the query criteria for the current
cursor location.

Returns to the main menu.

Displays the General User Preferences Maintenance Form
(GUAUPREF), which is used to customize Banner for
individual users. See "Title Bar Display Options," "Displayed
Form Names," and "Customized Main Menu," all in chapter 5,
Customization.

Lets you quickly re-access forms that were previously
accessed in this session (up to ten). See "Last 10 Forms in the
File Pull-Down Menu" in chapter 3.
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Edit Menu

This pull-down menu contains the functions used to edit text items.

Cut Cuts selected text and places it on the clipboard.

Copy Copies selected text to the clipboard.

Paste Pastes text from the clipboard to the spot where the cursor is
located.

Edit Displays the Editor window, which is used to enter or update

text. You can display this window from most fields. It is
particularly useful in long data fields. See "Using the Editor" in
chapter 4.

Options Menu
This pull-down menu contains navigation options.

Navigation options vary from form to form and depend on where the cursor is currently
located. Some options take you to other blocks and windows within the current form.
Other options take you outside the current form to related forms. For options that take you
outside the current form, you can optionally display the form name associated with the
option. You can set up this display option on the General User Preferences Maintenance
Form (GUAUPRF). See "Displayed Form Names" in chapter 5.

Banner is delivered with standard navigation options. Your system administrator can use
the Options Maintenance Form (GUAOPTM) to change and add navigation options for
your institution. Only those staff members with appropriate security can perform this task.

> Note
Only the first 24 options defined on GUAOPTM will appear in the Options
pull-down menu. n

Block Menu

This pull-down menu contains the functions used to navigate among the blocks of
information on a form.
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Previous

Next

Clear

Iltem Menu

Moves the cursor to the previous block that has at least one
enterable field. If the previous block is in another window, that
window is opened.

Moves the cursor to the next block that has at least one enterable
field. If the next area is in another window, that window is
opened.

Clears all information from the current block. (Information is
not removed from any records or tables.)

This pull-down menu contains the functions used to navigate among the fields or items on

a form.

Previous

Next

Clear

Duplicate

Record Menu

Moves the cursor to the previous enterable field (item) in the
current block.

Moves the cursor to the next enterable field (item) in the current
block. Occasionally, Next Item moves the cursor to the first
enterable field (item) in the next block.

Clears all information from the current field (item).
(Information is not removed from any records or tables.)

In a blank row of a repeating record, duplicates the contents of
the same field (item) in the previous record and copies it into the
new record.

This pull-down menu contains the functions used to work with records on a form.

Previous

Next

Scroll Up
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Moves the cursor to the first enterable field in the previous
record and triggers previous record logic coded into the form.

Moves the cursor to the first enterable field in the next record of
the current block and triggers next record logic coded into the
form. If the cursor is in the last record, a new record is created.

Scrolls up the list of repeating records, putting the first displayed

record near the bottom of the list.
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Scroll Down

Clear

Remove

Insert

Duplicate

Lock

Query Menu

Scrolls down the list of repeating records, putting the last
displayed record near the top of the list.

Clears all information from the current record. (Information is
not removed from any records or tables.)

Removes all information for the current record. When you Save,
the removed information is deleted.

Inserts a new blank record into the list of existing records.

Duplicates the contents of all fields in the record and copies
them into a new record.

Temporarily locks the contents of the record so no other Banner
user can update it. Save, Rollback, and Exit release the lock.

This pull-down menu contains the functions used to query information in the database
based on specified criteria. See “Querying Information” on page 3-28.

Enter

Execute

Last Criteria
Cancel

Count Hits

Fetch Next Set

Tools Menu

Puts the form into query mode so you can enter search criteria to
see what information is already in the database.

Searches the database and displays the first set of records that
match your search criteria.

Enters the criteria from your last search.
Cancels the query and takes the form out of query mode.

Counts the number of records that match the search criteria and
displays that number in the auto hint.

If more records match the search criteria than fit in the window,
replaces the current set of displayed records with the next set.

This pull-down menu contains actions that can be performed with Banner Document
Management Suite as well as options to submit or release a Workflow. Refer to the
documentation for Banner Document Management Suite or Banner Workflow for more
information about these options.
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Banner Document Submenu provides access to document management
Management Suite actions.

Workflow

Help Menu

Submenu provides access to workflow actions.

This pull-down menu contains various help tools.

Online Help

Dynamic Help
Query

Dynamic Help
Edit

Help (Item
Properties)

Show Keys

List

Banner General 8.0
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Displays online information for the current form. See "Online
Help" in chapter 4.

Displays the Dynamic Help Form (GUAHELP) in query mode,
which is used to display traditional help for a field, block, or
form. See "Dynamic Help" in chapter 4.

Displays the Dynamic Help Form (GUAHELP) in edit mode,
which is used to edit traditional help for a field, block, or form.
Use this feature to maintain custom information at your
institution. See "Dynamic Help" in chapter 4.

Displays the Oracle item properties window for the current field.
See "Help (Item Properties)" in chapter 4.

Displays the Keys list, which lists the functions and their
equivalent keystrokes available in your environment for the

current form, window, and field. See "Show Keys" in chapter 4.

Displays the List of Values (LOV) for the current field if List of
Values appears in the status line. See "Entering Information Into
Validated Fields" in chapter 3.
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Display Error

Display
ID Image

Calendar
Calculator

Extract Data
with Key

Extract Data
No Key

Technical
Support

Turn SQL
Trace On

Turn SQL
Trace Off

Set Query
Optimizer to
All Rows

If an Oracle error occurs, displays the code that is in error.

If the cursor isin an ID field, displays the image associated with
the ID, if available.

Displays the calendar. See "Using the Calendar” in chapter 4.
Displays the calculator. See"Using the Calculator"” in chapter 4.

Extracts Banner data for the current block, with key data, to a
spreadsheet. See "Extracting Banner Data to a Spreadsheet” in
chapter 3.

Extracts Banner data for the current block, without key data, to
a spreadsheet. See "Extracting Banner Data to a Spreadsheet" in
chapter 3.

This sub-menu provides access to SQL Trace, optimization
mode, and database reconnection features.

Turns the SQL Trace feature on. SQL Trace is a tool that helps
your technical support staff track performance issues that need
to be resolved. Refer to the Banner General Technical Reference
Manual.

Turns the SQL Trace feature off. SQL Trace is a tool that helps
your technical support staff track performance issues that need
to be resolved. Refer to the Banner General Technical Reference
Manual.

This cost-based optimization mode is recommended for testing
batch processing. Rather than immediately populating the
cursor, this option optimizes the query to get the best time for the
entire results set to be displayed. Because of this, it is a good
option for batch processing rather than online processing.

Note: You must be connected to an Oracle10g database in
order to use this option.

& Warning
Changing optimization modes mid-session
may cause your results to be invalid due to
cached data from previous queries.
SunGard Higher Education recommends
that you exit and re-enter Banner if want to
change optimization modes. L
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Set Query
Optimizer to
First Rows

Set Query
Optimizer to
Rule

Reconnect to
Database

About
Banner
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This cost-based optimization mode optimizes the query to get
the first set of rows as quickly as possible. It is useful for online
processing. DBASs can configure how many rows will be defined
as the “first rows,” for example, 1,100, 1000.

Note: You must be connected to an Oracle10g database in
order to use this option.

& Warning
Changing optimization modes mid-session
may cause your results to be invalid due to
cached data from previous queries.
SunGard Higher Education recommends
that you exit and re-enter Banner if want to
change optimization modes. u

This standard rule-based mode is based on sgl and database
schema, and optimization is based on Oracle rules in the
database (for example, if an index is present, then use it). It does
not optimize queries, but rather executes them based on a series
of Oracle rules.

Note: You must be connected to an Oracle10g database in
order to use this option.

& Warning
Changing optimization modes mid-session
may cause your results to be invalid due to
cached data from previous queries.
SunGard Higher Education recommends
that you exit and re-enter Banner if want to
change optimization modes. u

Reconnects to the database.

Displays the About Banner Form (GUAABOT), which
identifies the current form, release number, date, and time, as
well as all legal statements and copyright information for
Banner.

This form also displays a list of installed Banner products, their
release number, and their installation date. This information will
be helpful if you need to contact the ActionLine with a question
or problem.
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Toolbars

The Banner toolbar contains buttons that perform common functions. It is located directly
under the menu bar:

& Oracle Developer Forms Runtime - Web -8 x
File Edit Options Block Item Record Query Tools Window Help
HIAEEER Y REE G S BB GE

ubmission Controls GIAPCTL 7.0 70

toolbar

(o e
Process: | B| Parameter Set: | B

Tool tips describe the
functions of buttons

. '
PrimterComtrot

Printer: EI Special Print: Lines: Submit Time:

Parameter Values
Number Parameters Values

] ]

00000

Submission

[ Save Parameter Set as Name: Description: ' Hold ® Submit
Process Name, press SEARCH for valid processes. |
Record: 1/1 | ] | | <osc=

When you move your cursor over a button and pause, a tool tip appears with text that
describes the function of the button.

2 sE 2EE

To access a toolbar button:

Select the appropriate button. You can click a button any time, except when you are in a
dialog box, alert box, or List of Values (LOV). (You must respond to these window before
you can select a button.) If a button is dimmed, then it is disabled and cannot be clicked.
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Save

Rollback Next Block Print Workflow Release

Standard Buttons

Standard buttons are delivered on the toolbar:

Online Hel
View/Send Message nline Help

Select Previous Block

Workflow Submit FGAC Security Exit

BYE RCEE ¥ DEN Q& ME DRI EIH L@ 01X

Insert Record Enter Query Broadcast Messages Supplemental Data
Banner Docurment e
Remove Record Execute Query Management Suite Institution (MEP) Code
Previous Record Cancel Query BDMS Add Document
Next Record

Links on the Main Menu

In addition to the toolbar buttons, several links are available from the main menu.
Information about using these links is located in Chapter 3, “Getting Around Banner”.

Help Center
Object search Site Map
Refresh Menu tree
Products list —‘
Go To... EI Welcome, JSOL Products: F Menu | Site Map | Help Center
| Menu | Site Map | Help Center

Go To field
Welcome

Title Bar

The title bar shows the following information:
 Descriptive form name
» Form name (seven or eight characters)
* Release number

» Database name from the Installation Control Form (GUAINST)

Individual users can remove any of this information except the descriptive form name. See
"Title Bar Display Options" in chapter 5.

form description form name
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Blocks

A block is a section of a form or window that contains related information. If a form or
window contains more than one block, each block (except the key block) may be enclosed
in a beveled box.

& Uracle Developer Forms Runtime - Web

File Edit Options Block Item Record Query Tools Window Help

BO0 BOEE 58 E IR

@ X

"

key block Object:  [RECR_MAIR (=]
Description: L0 Major
** Press MEXT BLOCK to edit Object Rules, CLEAR BLOCK to delete Object **
other blocks ———— || Rules
' Data Element Operator Value ") AND f OR
=

[ - [sReRECR_MAR_cODE [= | [arecr_majr [ ] ] &
| A | o] | | o] | ]
| || | ) [ | | [ |
| || | | | | |
| il | | | | | | | |.
| || | | | | [ | |2
| ]| | | | | |
| A | o] | | o] | 7| |7
| || | ) [ | | [ |
| || | | | | |
| il | | | | | | |
| || | | | | [ |
[ & I [ 2 ®E

Oh]eches_nr\mmn‘

Most blocks have a title. There are three exceptions:
» A key block does not have a title.
 If a form or window has only one block, the block does not have a title.

* If a form has a key block and only one other block, the second block does not have
a title.

Key Block

The first block on most forms contains key information. (Some forms, especially
validation forms and certain list forms, do not have a key block.) The key block
determines what is entered or displayed on the rest of the form. All information on the
form refers to the key block.

The key block has at least one field and sometimes more. For example, a form that
maintains population selection information may have key block fields for both an
application and a selection ID..
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The key block stays on the form as subsequent blocks appear. Occasionally, another
window may appear on top of the key block if the window is unusually large or if the key
block is not pertinent to the window.

When the cursor is in the key block, enterable fields in the key block are enabled. When
you leave the key block, enterable fields in the key block are disabled.

Other Blocks

Other blocks contain additional details for the key information. Each block contains
related information and is usually enclosed in a beveled box.

Auto Hint

The auto hint at the bottom of the form can contain the following information for the field
where the cursor is located:

* Brief field description
 Error and processing messages

» Keyboard equivalents, if you can access other blocks, windows, or forms from the

field
keyboard equivalents:
LIST to display codes
COUNT HITS to display paragraph codes
field description —\ DUPITEM to display letter codes
|
T T 1
Paragraph Code; press LIST for codes, COUNT HITS Paragraph, DUPITEM Letter.
. Record: 117 |1 .. | Listafvalu.. | | <05C=
Banner General 8.0 June 2008
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Status Line

Event type code; press LIST faor walid codes.
status line — [Record: 141 | IList of Values [<D5C> [<DEG: |

The status line directly under the auto hint can contain one or more of the following
messages:

Record n/n Shows the number of the current record followed by the total
number of records in the current block. If there are more records
than fit in the window, the total appears as a question mark (for
example, 3/?) until you scroll to the last record in the block.
Once the last record is displayed, the total appears as a number
(for example, 3/15).

List of Values Indicates the field has a List of Values; see "Entering
Information Into Validated Fields™ in chapter 3.

Enter Query Indicates the form is in query mode.

Elements on a Form

The following figure shows various elements that appear on forms. Each element is
described on the following pages.

File Edit Options Block Item Record Query Tools Window Help

buttons
Recipient: ) ETter: Date: @ Time: ’7 =
Message: ‘ \@ Source: ’7
Reference ID: ‘ E‘ Item: ’7
System: ’_B
radio (‘] Complete L] Ili'ending  Haold [ confidential
buttons — s
Recipient: F Sender: ’7 Date: yiﬁ Time: ’7
field ﬁ [7 source: ’—
lelds Reference ID: ‘ [7‘ Item: ’7
e
2 Complete T pending T Haold [ confidential
checkbox I
Recipient: fiF Ssender: ’7 Date: ’7[7 Time: ’—
Message: ‘ [? Source:
record Reference ID: ‘ [7‘ Item: ’7
System: ’7"7
@ Complete © Pending T Hold [ confidential
|
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Buttons

Buttons are visual images used to perform an action or respond to the system. Banner
forms use iconic buttons and response buttons.

Iconic Buttons

These buttons are small squares that contain an icon (picture). They represent one or more
actions that can be performed for the associated field or record. For example, you can use
iconic buttons to display a validation form for the field, copy a record, or display a
window for entering freeform text.

Banner forms use the following buttons. (Some products do not use all buttons.)

=i Displays another form or window where you can search for a
|_| value or information related to the field. You can often select and
Search return a value to the associated field.
s Note
Sometimes the Search button can perform
more than one function. In these cases, an
Option List appears. You can select an
option from the list using your mouse, or
you can tab among the choices and use
the Enter key or space bar to make your
selection. u
@ Displays a calendar so that you can choose a date.
|
Calendar
Indicates that data is available for the associated field.
Data
|Tj| Indicates that no data is available for the associated field.
No Data
= Displays summary information for the associated record.
=]
Summary
(| Displays details for the associated record.
=] P
Details
|
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&

In Process

=

Complete

63

Maintenance

L |
L

Copy

t7d
Comments
5

=
Calculate

Approve

X
Disapprove

Generate ID

Indicates the process has started but is not complete.

Indicates the process is complete.

Updates information in the database.

Copies the current record or records.

Displays a window where you can enter freeform text for the

associated record.

Performs a calculation on data in the associated field.

Indicates the process is approved.

Indicates the process is not approved.

Generates a new ID.

If a field has an iconic button, the auto hint identifies the equivalent function that can be
used instead of the button. If the button can perform more than one function, each
equivalent is identified in the auto hint.

Banner General 8.0
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To select an iconic button:

®

1. Click the button. 1. Select the Next Item function until
you reach the field that has the

2. Ifan Option List appears, click the button.

desired option.

2. Read the auto hint and select the
Otherwise, the f(_)rm or window equivalent function. (A field may
appears automatically. have more than one option.)

Response Buttons

Cancel |

These buttons are shaded rectangles that appear in alert boxes and dialog boxes. An alert
box has one response button. A dialog box has two or more response buttons. You must
use the buttons to respond to the system before you can continue.

To select aresponse button in an alert box:

%

Click the OK button. Press Enter.

To select aresponse button in a dialog box:

% o

Click the desired button. Select the Next Item function or use the
left and right arrow keys to move to the
desired button. Then press Enter.

OR

Press the underlined letter on the
desired button.
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Check Boxes

Selected:
¥ tare Detail?

Not selected:
I Mare Detail?

Check boxes are small boxes used to enable or disable features or options. When an option
is enabled, a check mark appears in the check box. When the option is disabled, the check

box is empty.

Check boxes often represent yes/no conditions. For example, the first sample above
indicates the record has more detail. The second sample indicates the record does not have
more detail. Sometimes check boxes indicate navigation to other windows. The auto hint
tells you when a check box is used for this kind of navigation.

To select or clear a check box:

Y &
) 1. Select the Next Item function to
Click the check box. If the box was move to the check box.
unchecked, it is now checked. If the box
was checked, it is now unchecked. 2. Press the space bar. If the box was

unchecked, it is now checked. If
the box was checked, it is now
unchecked.

Note: If the space bar does not toggle a
check box, it may not be defined on your
system. Check with your data center
personnel.

Radio Buttons

June 2008

i Invitea
© Guest
& Both

Radio buttons are small circles used to select one of several options in a group. Each radio
button represents a choice for the group. You can pick only one radio button in a group.
When you select a radio button, the previously selected button is cleared. In the sample

above, the Both button is selected.
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To select aradio button:

3 =

_ _ 1. Select the Next Item function to
Click the radio button. move to the radio group.

2. Press the left or right arrow key to
move to the desired radio button.

Scroll Bars

|»

T i

Scroll bars are used to display overflow information when a form has more information
than can be displayed at once. They also indicate that a form has an unlimited number of
repeating records.

A scroll bar has an arrow on each end and a scroll box in the middle. The position of the
scroll box shows approximately how far you are from the top/bottom or the right/left side
of the window.

Forms can have two kinds of scroll bars:

» A vertical scroll bar, located directly to the right of the rows, indicates there are
more records than are shown. A record can have one or more fields and one or
more lines. A vertical scroll bar is disabled if all the records appear at once.

» A horizontal scroll bar, located directly under the window, indicates there are more
columns of information than are shown.
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To use a scroll bar:

Y &
Click and drag the scroll box up/down 1 select the Next Item function to
(vertical) or left/right (horizontal). move to one of the fields controlled
OR by the scroll bar.

Click the arrow at either end of the 2. To move up and down (vertical
scroll bar. The scroll box moves in the scroll bar), select the Next Record
direction of the arrow. or Previous Record function.

OR OR

Click anywhere in the scroll bar. The To move left and right (horizontal
scroll box moves between the previous scroll bar), select the Next Item or
location and where you click. Previous ltem function.

Fields

Fields are areas on a form where you can enter, query, change, and display specific
information. A field is sometimes called an item. This is the case in the names of the
functions Next Item, Previous Item, and Duplicate Item. The following terms describe a
field:

Date: | @I

Source: |

Item: |

» Enabled. You can put the cursor in the field. Information in the field appears in
black text.

 Disabled. You cannot put the cursor in the field. Information (if it exists) appears
in black text, the same as enabled fields. Your site administrator may choose to
change the color of disabled text for your site. Refer to the Banner Middle Tier
Implementation Guide for more information.

» Enterable. You can enter information in the field. The field is usually enabled. In
certain situations, however, it may be disabled.

 Display only. You cannot enter information in the field.

Some fields are usually enabled but may be disabled occasionally. For example, in query
mode sometimes you cannot query a field that is normally enabled, and sometimes you
can query a field that is normally disabled. This is also true for enabled fields in a key
block; once you leave the key block, all fields in the key block are disabled.
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The current record
is highlighted.

Text fields may appear to be a few characters longer than they actually are. For example, a
field that allows up to 60 characters may look like it still has space after the sixtieth
character. This is because each character uses a different amount of space.

To access an enterable field:

)

Click the field.

Select the Next Item function until the
cursor is in the field.

Records, Rows, and Columns

A record is a set of related fields. For example, a street, city, state, and ZIP/postal code
form an address record.

If a block has multiple records, the records often appear in rows and columns. A horizontal
scroll bar appears under the columns if all columns don’t fit into the window at once. A
vertical scroll bar appears on the right side of the rows if all rows don’t fit into the window
at once. When you select a row, the entire record is highlighted to identify it as the current
record.

This sample shows a form with multiple printer records:

’7_9 Printer validation GTWPRWT 7.0 (s4b70) -7
Code Description Command Printer Port Landscape Codes Portrait Codes Activity Date
— |#fsctmntzo/sES_D [3Cv 3rd Floor East Wing Develo [print faueus=ses_de | [ [ lb3-DEC-z004  ~

[1an Pan's schedules |echa "Hello” [ [ [ |07-FEB-2005
[traz: [Lpa1 [ [ [ [ [14-MaR-1995
|tres: |ipbs [ [ | | [14-MaR-1995
[monE [none [ [ [ [ [14-maR-1595
[noprINT |oont print [ [ [ [ [ze-nov-z003
[scHeD [student Sehedules [enscript -Pses_dev_ | [ [ oe-Fee-2005
[ses_pEw_s1so | [3cw 3rd Floor East Wing Develo [1p - ses_dev_s1sn] | [ [ [13-DEC-2004
[ses_pcam_sio0 | [Bv cvmor [lor 5149.24.35.22 | [ [ [o2-DEC-2004
[losan |Local Rs600D - Malvern [ [ [ [ [11-MOV-1093
[lacalz [Local RE6000 - Trvine [ [ [ [ [11-nov-1993
[nene [none [ [ [ [ [14-MaR-1995
sctrnt20:ses_dev_ |3cv third floor rm 331 13-DEC-2004
schrtall Rochester West Wing Talaris print /queus=sctral 08-MOW-1995
tall Talaris Printer 1 - Malvern 11-MOY-1993
[tatz [Talaris printer 2 - Malvern [ [ [ [ [11-MOV-1093
[tatz [Talaris Printer 3 - Reston [ [ [ [ [11-NOV-1893
[ [ [ [ [ [ [
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Pull-Down Lists

£
Other Protected Weteran Only
Wietnam Weteran Only

Both Wietnam/Other Elighl. Vet

Pull-down lists are used to select a field value from a list of pre-defined values. A down
arrow in the right side of the field indicates the field has a pull-down list.

5 Note
Fields with a Search button have a similar-looking down arrow. Pull-down
lists have the arrow inside the field, while the Search button is located
outside the field. n

To select a value from a pull-down list:

' &

1. Click the field. The entire pull- 1. Select the Next Item function to
down list appears with the move to the pull-down list.
currently selected item highlighted.

2. Press the Alt and down arrow keys
2. Click the desired item. The simultaneously to display the entire
selected value appears in the field. pull-down list with the currently
selected item highlighted.

OR

Press the down arrow key to scroll
through the list items one at a time.

3. Use the arrow keys to move to the
desired item.

OR

Type a character to highlight the
next item that begins with that
character. For example, to choose
Inactive, type I. If more than one
item starts with I, then the first item
that starts with I is selected.
Continue to press | until the correct
choice appears.

4. Press Enter. The selected value
appears in the field.
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Oracle Functions Used Iin Banner

Oracle functions trigger actions within a form. The following list describes the Oracle
functions commonly used in Banner. For more complete technical descriptions, refer to

your Oracle documentation.

5 Note

Banner sometimes redefines the standard Oracle functions to perform
other functions. For example, Count Query Hits often calls another form.
Use the Show Keys function to list the functions defined for the current
form, window, or field. =

Cancel

Clear Form
Commit
Count Hits

Count Query Hits

Down
(arrow key)

Edit

Enter Query

Execute Query

2-36 Banner General 8.0
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Exits you from an Option List, List of Values, Editor
window, or Dynamic Help without making a selection or
saving information.

See Rollback.
See Save.
See Count Query Hits.

In query mode, counts the number of records that match the
search criteria and displays that number in the auto hint. To
retrieve records, select the Execute Query function.

Also referred to as Count Hits.

Moves the cursor to the first enterable field in the next
record, moves you lower in a List of Values, or moves you
lower in a pull-down list.

Down is similar to Next Record without next record logic.

Displays the Editor window, which is used to enter or update
text. It is particularly useful in long data fields.

Puts the form into query mode so you can enter search
criteria to see what information is already in the database.
Enter Query appears in the status line. For more
information, see "Querying Information™ in chapter 3.

In query mode, searches the database and displays all records
that match your search criteria. For more information, see
"Querying Information™ in chapter 3.
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Exit Forms and windows
Exits you from the form or window.

Main menu
Exits you from Banner.

Query mode
Cancels the query and takes the form out of query mode.

Also referred to as Exit without Value.

Exit with Value Called form
Returns you to the calling form and enters the selected value
into the field that called the form.

List of Values (LOV)

Returns you to the calling form and enters the highlighted
value into the field that called the form. The OK button
corresponds to Exit with Value.

Also referred to as Select and Next Primary Key.

Exit without Value See Exit.

Help Displays the Oracle item properties window for the current
field.
List Displays the List of Values (LOV) for the current field if List

of Values appears in the status line.

Next Block Moves the cursor to the next block that has at least one
enterable field. If the next area is in another window, that
window is opened.

Next Field See Next Item.

Next Item Moves the cursor to the next enterable field in the current
block. Occasionally, Next Item moves the cursor to the first
enterable field in the next block.

Also referred to as Next Field.
Next Primary Key  See Exit with Value.

Next Record Moves the cursor to the first enterable field in the next record
of the current block and triggers next record logic coded into
the form. If the cursor is in the last record, a new record is
created.

Next Record is similar to Down with the addition of next
record logic.
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Previous Block

Previous Field

Previous ltem

Previous Record

Rollback

Save

Scroll Down

Scroll Up
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Moves the cursor to the previous block that has at least one
enterable field. If the previous block is in another window,
that window is opened.

See Previous Item.

Moves the cursor to the previous enterable field in the
current block.

Also referred to as Previous Field.

Moves the cursor to the first enterable field in the previous
record and triggers any previous record logic coded into the
form.

Previous Record is similar to Up with the addition of
previous record logic.

Application and inquiry forms

Clears all information (except key information) and returns
you to the first enterable field in the key block. If you enter
changes and do not save them before trying to roll back, you
are prompted to save.

Validation forms
Returns you to the first enterable field on the form.

Query forms
Returns you to the first enterable field on the calling form.

Also referred to as Clear Form.

Saves all changes entered since the last time you saved.

Also referred to as Commit.

Scrolls down the list of multiple records, putting the last
displayed record near the top of the list.

Scrolls up the list of multiple records, putting the first
displayed record near the bottom of the list.
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Select See Exit with Value.

Show Keys Displays the Keys list, which lists the functions and their
equivalent keystrokes available in your environment for the
current form, window, and field.

Up Moves the cursor to the first enterable field in the previous
(arrow key) record, moves you higher in a List of Values, or moves you
higher in a pull-down list.

Up is similar to Previous Record without previous record
logic.
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3  Getting Around Banner

n

Banner provides numerous ways to navigate through the system:

Main menu

Direct Access

Object Search

Site map
Tabs

Options menu

Option list

Buttons

Mouse

Keyboard
equivalents

QuickFlow

Last 10 formsin
the File pull-
down menu

Display
Navigation
Window key

You can select from a list of the menus, forms, jobs, and QuickFlows
in Banner.

You can access a menu, form, job, or QuickFlow by its name.

You can access a form, job, or QuickFlow if you know part of its name,
description, or type.

You can view a list of the top-level menus and one level below them.
You can access windows on tabbed forms by selecting the tab.

You can access other forms, windows, and blocks related to the current
form, window, and block.

You can right-click on a form anywhere outside a field to display the
Option list, from which you can perform functions, navigate to other
parts of the form, or add the form to your personal menu.

You can access another form or window related to the current record
or field.

You can click an iconic button, field, record, block, or window that is
currently displayed.

You can use the keyboard to access a form, window, block, or field.

You can automatically access forms that are linked in a chain.

You can quickly re-access a form that was previously opened in the
current session.

You can press this key on any form to display a navigation window that
enables you to enter the name of another form or job and navigate to it.

Banner General 8.0 3-1
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Main Menu

You can use the main menu to select from a list of the menus, forms, jobs, and QuickFlows
in Banner. The main menu shows the various levels of menus at your institution. These
levels are nested within a hierarchical folder structure. You can easily navigate through
Banner by expanding and collapsing these menus. Once you have “drilled down” to the
item you want, you can click its link to access it.

Refer to chapter 2 for more information about the .
To expand or collapse a menu:

Select the folder (or its associated description) to expand the menu so you can see the
objects it contains. Select the folder again to collapse it.

To access a menu item:
1. Expand the menu you want to start with (for example, General).

2. Continue expanding menus until you drill down to the form, job, or QuickFlow you
want.

3. Double-click the name of the form, job, or QuickFlow you want to access.

Direct Access

You can use Direct Access to access a menu, form, job, or QuickFlow by its name. You
can use Direct Access from the main menu or from a form.

To use Direct Access from the main menu:

1. Enter the name of the menu, form, job, or QuickFlow in the Go To field.
2. Press Enter.

5 Note

You cannot search for an object using code/description lookup in this
field. You can, however, search by selecting the Search button and then

performing your search on GUIOBJS. =
u) Tip
While in the Go To field, you can use the up and down arrow keys to
scroll through the list of your recently accessed forms. =
|
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To use Direct Access from a form:
i Note
When you use Direct Access from a form, the current form remains open.

When you exit the requested form, job, or QuickFlow, you return to the
original form. [

1. Select File>Direct Access. The Direct Access Form (GUAPARM) appears.

2. Enter the name of the form, job, or QuickFlow in the Enter Valid Name field. (You
cannot use Direct Access to access a menu from a form.)

3. Click the Start button or press Enter.

Object Search

You can use Object Search to access a form, job, or QuickFlow if you know part of its
name, description, or type.

When you use Object Search from a form, the current form remains open. When you exit
the requested object, you return to the original form.

> Note
You cannot search for an object using code/description lookup in this
field. You can, however, search by selecting the Search button and then
performing your search on GUIOBJS. [ ]
To use Object Search:
1. Double-click the Go To field on the main menu. You can also use the Search button.
OR
Select File>Object Search from any form.

2. Enter your search criteria on the Object Search Form (GUIOBJS).

You can use any or all of the Name, Description, and Type fields. You can use the
Oracle wildcards % and _. (See "Wildcards" in this chapter.)

3. Select the Execute Query function. A list of all matches appears.

4. Scroll to the desired name.
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5. Double-click the desired name or click the Start button.

> Note

You can use the up and down arrow keys within the Go To field to scroll
through forms that you have previously accessed in the Banner session.
Press Enter to go to that form.

Site Map

The site map appears on a separate page accessible by selecting the Site Map link on the
main menu. It lists the top-level menus in your installation, and one level below them.
There are no fields on it, only links to the various menus and forms.

My Banner
Ernpty; Select to build.

Student

Course Catalog

Class Schedule

General Person

Faculty Load

Location Management and Housi
Recruitrnent

Adrnissions & Stuff

General Student

Reqistration

Accounts Receivable

Acadernic History

Curriculum, Advising and Progra
Student Systermn Management
Student Adrinistration
Information Access

Advancement
Advancernent Individual
Advancement Organization
Membership

Prospect Managernent
Designation

Solicitor Organization
Campaign

Pledge

Gift and Pledge Payment
Event Management
Advancerment QuickFlow
Advancement Self-Service
External Data Load and Extract

Finance

General Ledger

Finance Operations

Stores Inventory
Purchasing and Procurement
Accounts Payahble

Budget and Position Control
Fixed Asset

Cost Accounting
Endowment Management
Investment Managerment
Accounts Receivable

Banner Broadcast Messages

Human Resources
Applicant Administration
Electronic Approvals
Biographic/Dermographic Inform
Employment Administration
Compensation Adrinistration
Ermployee Relations Administrati
Health and Safety Administratior
Benefit / Deduction Adrninistratic
Fosition Managernent

Personnel Services Budget
Time Entry and Payroll Processin
Payroll History

Hurnan Resources Administratior
Security Set up
Cornrnittee/Service

Financial Aid

Applicant Processing

Meed Analysis

Requirements Tracking
Budgeting

Packaging and Disbursement
Funds Management
Electronic Data Exchange
Histary and Transcripts

Financial Aid Cornmon Functions
S nrd Cumbnre Choend Dok

General

Job Subrission

Population Selection

Letter Generation

General International Manageme
Systern Functions/&dministration
Event Managerent

General web Management

|»

General Voice Response Manage | -

Banner XtenderSolutions

Bx= FinAid Requirements Linking :

Bx= Student Requirements Linki
Bx= Student Requirements Linki
Bx= Application Yalidation Form
Bx= Document Type YValidation F
BXS Context Determination Forn
BXS Systern Settings Form

BXS Error/Result Form

Business Processes
Manage the Enterprise
Matriculate to Educate
Forecast to Enroll

Plan to Fund

If you select a menu from the site map, the main menu appears, displaying the menu you
selected with one level expanded. If you select a form, a process, or a QuickFlow, it will

be displayed.

Tabs

Certain forms feature a tabbed interface. Tabs are used to arrange information in a
meaningful way, and allow you to navigate easily between groups or blocks of
information. Tab titles reflect the contents of a particular window or grouping of

information.

For tabbed forms that contain windows of parent/child information, the main (“parent”)
tab appears in the top row. The dependent (“child”) information appears on tabs lower on
the window and below the top-level tab to which the information is related.
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To navigate between tabbed windows:

3 =

* Click the tab. » Control-Tab moves forward and
Control-Shift-Tab moves backward

* The List Tab Pages key (F2) through the tabs on a form.

displays a list of other tabbed

windows on the form. Use the « Control-Page Up moves forward
mouse to select a different tab from and Control-Page Down moves
the list. For forms that have tabs backward through the tabs.

within a tabbed window, navigation
is based on the location of the cursor
when List Tab Pages is selected.

e The List Tab Pages key (F2)
displays a list of other tabbed
windows on the form. Use the up
and down arrow keys to select a
different tab from the list. For forms
that have tabs within a tabbed
window, navigation is based on the
location of the cursor when List Tab
Pages is selected.

Options Menu

June 2008

You can use the Options menu in the menu bar to navigate within Banner. Options in the
menu depend on where the cursor is currently located. Some options take you to other
blocks and windows within the current form. Other options take you outside the current
form to other related forms.

The Options menu optionally displays the form name associated with each option that
takes you outside the current form. You can set up this option on the General User
Preferences Maintenance Form (GUAUPRF). See "Displayed Form Names" in chapter 5.

Banner is delivered with standard navigation options. The system administrator at your
institution can use the Options Maintenance Form (GUAOPTM) to change and add
navigation options for your institution. Only those staff members with appropriate security
can perform this task.

> Note
Only the first 24 options defined on GUAOPTM will appear in the Options
pull-down menu. [
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To select an option in the Options menu:

% &
1. Click the Options menu. 1. Press the Alt key. The cursor
Navigation options appeatr. moves to the menu bar.
2. Click the desired navigation 2. Use the right arrow key to
option. highlight the Options menu. Then

press Enter.
OR

Press the letter O on your
keyboard. Navigation options
appear.

3. Use the up and down arrow keys to
highlight the desired navigation
option. Then press Enter.

OR

Press the underlined letter for the
desired navigation option.

Note: If the Options menu contains
multiple menu items that begin with the
same letter, you must use the up and
down arrow keys to select the desired
menu item.

Option Window

When you right-click anywhere on a form (except from within a field), the pop-up Option
window appears. It contains different options related to the form, such as functions you
can perform and navigation options. You can also choose to add the form to your personal

menu.
> Note
To see the form that you just added to your personal menu via the Option
window, you must first refresh the menu by either clicking the Menu link
on GUAGMNU or entering REFRESH in the Go To field. [
|
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Rollback
| Save

Exit

Print

Add to Personal Menu

| Display Options
Directory Options
My Links

| Menu Settings
LD&P

The Option window displays a list of
form-specific options..

To select an option in the Option window:

D

0]

1. Right-click on the form (but not
from within a field). The Option
window appears.

2. Click the desired option.

Note: There is no keyboard equivalent
for the Option window; however, most
options are available from either the
File or Options pull-down menu.

1. Press the Alt key. The cursor
moves to the menu bar.

2. Use the right arrow key to
highlight the File or Options
menu. Press Enter.

OR

Press the letter F or O on your
keyboard. Options appear.

3. Use the up and down arrow
keys to highlight the desired
option. Then press Enter.

OR

Press the underlined letter for
the desired option.

Note: If the Options menu contains
multiple menu items that begin with
the same letter, you must use the up
and down arrow keys to select the
desired menu item.

Banner General 8.0 3-7
Banner Getting Started Guide
Getting Around Banner



Iconic Buttons

You can use iconic buttons to access a form or window related to the record or field where
the cursor is currently located. See "lconic Buttons” in chapter 2 for a more detailed
description of iconic buttons.

To select an iconic button:

Y &

1. Click the button. 1. Select the Next Item function until
you reach the field that has the

2. Ifan Option List appears, click the button.

desired option.

2. Read the auto hint and select the
Otherwise, the form or window equivalent function. (A field may
appears automatically. have more than one option.)

Mouse

You can use the mouse to navigate to an enterable field, record, block, or window that is
currently displayed. You can access fields in any order. You can also use the mouse to
click buttons.

Keyboard Equivalents

You can use the keyboard equivalents of Oracle functions to access a form, window,
block, or field.

To access a form with keyboard equivalents:

1. Read the auto hint message to determine whether a redefined Oracle function lets you
navigate to another form. (Count Query Hits, Duplicate Item, Duplicate Record, Exit
with Value, and List are the most commonly redefined functions.)

2. If aredefined function is available, use Show Keys to find the keyboard equivalent
for the redefined function.

3. Use the keyboard equivalent to access the form.
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To access awindow or block with keyboard equivalents:

Use the keyboard equivalents for Next Block and Previous Block to move among blocks.

If the next/previous block is in another window, these keys take you to another window.

3 Note
Occasionally the Next Block function appears to move the cursor to
another enterable field in the same block. In these cases, there are
actually two blocks that visually appear to be one block. =

To access a field with keyboard equivalents:

Use the Tab key (Next Item) and Shift+Tab keys (Previous Item) to move among fields.
You must move in the specific order coded into the form. If a field has the Autoskip

feature, the cursor automatically moves to the next field as soon as you enter the required

number of characters.

QuickFlow

You can use a QuickFlow to automatically access forms that are linked in a chain.
Activating a QuickFlow opens the first form in the chain. When you exit that form, the
next form automatically opens.

To use a QuickFlow:

1. Select File>QuickFlow or use Direct Access to display the QuickFlow Form
(GUAQFLW).

2. Enter the QuickFlow code in the Quickflow field.

3. Click the Start button, press Enter, or select the Next Block function. The first form
in the QuickFlow appears.

4. Enter data on the form.
5. Exit the form. The next form in the QuickFlow appears.

6. Repeat steps 4 and 5 for each form in the QuickFlow. After you pass through all the
forms in the QuickFlow, the GUAQFLW Form reappears.

5 Note
If you want to exit the QuickFlow before all the forms are accessed, select
File>Exit QuickFlow. n
b Note

If you do not have any data to enter on a form, exit the form. If the
message DO YOU WANT TO QUIT? appears, answer Y. (The message
depends on the form.) m
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7. If you are finished with the QuickFlow, exit the GUAQFLW Form.
OR

If you want to execute the QuickFlow again, return to step 3.

Last 10 Forms in the File Pull-Down Menu

You can quickly re-access a form that was previously opened in the current session. The
bottom of the File pull-down menu lists the last forms (up to ten) you used in this session.
You can re-access any form in the list.

> Note
The only forms that never appear in this list are the QuickFlow Form

(GUAQFLW), Direct Access Form (GUAPARM), and Object Search Form
(GUIOBJS). [

To access a form from the File pull-down menu:
1. Access the File pull-down menu.

2. Select the form name from the list at the bottom of the pull-down menu.

Display Navigation Window Key

The Display Navigation Window key displays a navigation window on the top of your
screen that allows you to enter the name of a form and then navigate to it. Usually this key
is F5, but your institution may use a different key.

The navigation mini-window also contains the My Institution link that appears on the
main menu.

To exit the navigation window, press F5 (or equivalent at your site) again, or perform a
Next Block or Previous Block function.

W Tip
On some forms, you can click a form field as a way of closing the
navigation window. But this method only works for forms with updateable
fields. Using F5 (or equivalent) to close the navigation window works on
all forms. [

igGEl‘wEer'a\ Person Identification SPAIDEM -1l

. : red by
Go To... | ] My Institution:  http: /fwww.sungardhe com SUNGARD' HIGHER EDUCATION
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To use the Display Navigation Window key:
1. Press the Display Navigation Window key (F5) from any form.

2. Enter the name of the form in the Go To field, or use the Search button to search for
the form name.

3. Press Enter.

5 Note
The Display Navigation Window key does not work in query mode. m
¥ Tip
While in the Go To field, you can use the up and down arrow keys to
scroll through the list of your recently accessed forms. |

Entering Information

This section tells you how to enter information on Banner forms. Recommendations for
formatting data are included at the end of this section.

Entering Information Into Validated Fields

June 2008

Many fields only accept codes from a defined list of values (LOV). Most codes and and
their associated descriptions in an LOV are defined on a form.

You can access the LOV for a Code/Description field by either clicking the Search
button or by double-clicking in the field.

> Note
If you double-click a field other than Code/Description that has a LOV,
the LOV will not open. (You must use the Search button or keyboard
equivalent.) You can use the User Preferences Form (GUAUPRF) to
change the color of Code/Description fields to help you visually identify
fields in which double-clicking invokes an LOV. [

Some forms contain more than just the valid codes and their associated descriptions. For
example, the Site Code Validation Form (STVSITE) includes address information. When
an LOV is called from a specific field, only information that is relevant to the current form
is displayed in the LOV.

Using the Code/Description Lookup Feature

The code/description lookup feature helps you enter information into validated fields.
With this feature you can:
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» Enter a complete code or description
» Look up a code or description based on a partial entry

« Display the entire LOV and select a code

If you look up a code/description or display the entire LOV, you can refine your search by
entering search criteria or use a drill-down search.

To enter a complete code or description in a field with an LOV:

1. Enter the full code (for example, A005) or full description (for example,
Registration).

2. Press Enter. The code and description appear. Depending on the field, the cursor may
automatically skip to the next field.

To look up a code or description in a field with an LOV:

> Note
Do not use these steps if you are in query mode. Instead, execute a
normal query. See "Querying Information™ in this chapter for more
information. =

1. Enter as much of the code or description as you know. Use the Oracle wildcard % to
represent any number of unspecified characters.

Example:

Enter A% to search for all codes and descriptions that start with “A”.

5 Note
If there is no wildcard, the search looks for an exact match. n

2. Press Enter.

« If one match is found, the code and description are returned, and this
procedure ends.

« If more than one match is found, the Search Results window appears with all
matches. Continue with step 3.

« If no matches are found, the auto hint displays an error message. Return to
step 1 to enter another code or description.

3. Scroll (if necessary) to the desired value in the Search Results window.

4. Double-click the value or press Enter. The window closes, and the selected value is
returned to the code field.
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File Edit Options Block Item Record Query Tools Window Help

BOE BEABE %9 BEE DI

BRI @ X

55 BLilding Definition. SLABLDG

Building: eIOL ¥ | Biology Building

Building Definition

Flnd|Cnnference-%

E Conference-$100 per day

100

Campus: B ~ | Blacksburg Canference-$200 per day 200
Site: 002 | ¥ Unit test gen 002 Caonference- $350 per day C350
Capacity: 500 Max
College: aH | 7 College of allied Healtl
E Department: ART v oAt @ W
nter a Partition: 01 ¥ Test
partial COde. Room Rate: C% ¥ | Conference/s 100 per day
Phone Rate: PRUM ¥ Private Lpfe-Montly Rat

Street Line 1: 125 testers Anon
Street Line 2:
Street Line 3:
City:

State or Province: PA
County Code: ool

Press Enter. This
window appears if
more than one match
is found.

Malvern

¥ Pennsyania

Go to the code you
want and double-
click it.

Phone: Key Number:

To display the entire LOV for a field with an LOV:

D

ZIP or Postal Code: 19355 ¥

1. Double-click the Code field, or click the
Search button.

Note: If you are on a form that was called from a
field on another form, press the

Ctrl key before you double-click. (Double-clicking
by itself selects a value rather than displays an
LOV.)

If more than one form or window is
associated with the field, an Option List
appears. Click the option that displays the
LOV.

2.

Otherwise, the LOV appears automatically.

3. Scroll (if necessary) to the desired value in
the LOV.
4. Double-click the value. The LOV closes,

and the selected value is returned to the
Code field.

Select the Next Item function until
you reach the Code field.

Select the List function. The LOV
appears.

Scroll to the desired value in the
LOV (if necessary).

Press Enter. The LOV closes, and
the selected value is returned to the
Code field.
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File Edit Options Block Item Record Query Tools Window Help

T

AEWNT

Event: A0017

EEE v BEX & BE ok

¥ Arks Review Committes

Event Details

Description:

Arts Review Comr

M Committee or

@ 1 X

Campus VYalidation (5 o e

Find| %

Activity Date
19-MAR-2004

Description

19-MAR-2004

Campus 100 19-MAR-2004

12 Two-chardcter code 19-MAR-2004

123 Three-character code 19-MAR-2004

2 Off Campus 19-MAR-2004

c} Japan Jenter 19-MAaR-2004

4 Coop Frogram 19-MAR-2004
S University Fmnlnyeea 19-MAR-ZNNG =

¥ Univeptity Employee

X System: H ¥ Human R
Double-click :
this field, or Event Type: SEMN ¥ Semi
choose the Agency or Commercial ID:  B70100 ¥ |RH
Search button. Contact ID: ¥

Address Type: L4
Phone:
Campus:
ThisLOV Site: 001
appears. District or Division: ENG

Go to the code
you want and
double-click it.

College:
Department:

- D;«din Site

* Engineering Divisio

07 | ™ University of British Zolumbia

2415

¥ Fine Arts

To refine your search in an LOV or Search Results window:

1.

Click the Find field in the LOV or Search Results window.

Enter your search criteria.

Use the Oracle wildcard % to represent any number of unspecified characters. Use the
Oracle wildcard _ to represent one occurrence of an unspecified character. You can
use both wildcards in the same search string.

Examples:

Enter A% to search for all codes and descriptions that start with “A”.
Enter _AID to search for all four-character codes that end with “AlD”.

Click the Find button or press Enter.

Campus Validation (

Fmd‘:%

Click this field.

Code
=

CE2
CEN
cP

Description
Charlottesville

Central Campus - vale
Central Campus

CcP

Activity Date

24-1UN-1991
19-MAR-2004
19-MAR-2004
18-MAR-2004

Enter your search

Click this button.

{ ;
S —Eaneet
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To use a drill-down search in an LOV or Search Results window:

1. Inthe LOV or Search Results window, press the first character of your search string.
The list displays all codes that begin with that character.

2. Press the next character in the string. The list displays all codes that begin with the
two characters entered.

3. Keep adding characters to reduce the list of matches.

When you see the code you want, double-click it or press Enter. The code is returned
to the field.

OR

When you have reduced the list to one match, the code is automatically returned to the
field.

Department Validation (STVDEPT) -+

Start with a full list of values
for department codes.

Code  Description Sys Reqg WR Mesi =
2210  General Engineering et
2220  Chemical Engineering

2230  Chemistry

(B} e el e e e = e S B AR R e e P T I

2250

2255 .
2256 | Finde% Press the character E. The list
T T vwes= | shows all codes that start with

ECEL
ECO Ecanomics N
Sl Department Validation (STVDERT)
EDS EDS
EDT Edug

FindlenG% .
B b - Press the character N. The list

ENG Engl .
0 Description 222 | shows all codes that start with

English EN.

ENGR  Engineering
ENGT  Engineering Technology

You can choose a value from
the list or continue entering
3 X B I + | characters until you get a

(Eind ) Canel single match.
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Entering Information From Another Form

Sometimes the Search button next to a Code/Description field takes you to another form
to look for values, rather than to an LOV. You can select information from the “called
form,” and return it to the current field.

To enter information in a field from a called form:

Y &

1. Click the Search button. 1. Select the Next Item function until
you reach the field that has the

2. Ifan Option List appears, click the button.

desired option to display the form.

) 2. Read the auto hint and select the
Otherwise, the form appears equivalent function. (A field may
automatically. have more than one option.) The

form appears.
3. If the form opens in query mode,

enter your search criteriaand select 3 |f the form opens in query mode,
Execute Query. The form displays enter your search criteria and select
matching values. Execute Query. The form displays

Otherwise, the form displays matching values.

available values. Otherwise, the form displays

) ) available values.
4. Scroll (if necessary) to the desired

value on the called form. 4. Scroll (if necessary) to the desired

) value on the called form.
5. Double-click the value. The called

form closes, and the selected value 5 Choose the Select function. The
is returned to the field. called form closes, and the selected
value is returned to the field.
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&% Dracle Developer Forms Runtime - Web
File Edit Options Block Item Record Query Tools Window Help
ROERERE &P/ B & EE S

%5 Process Submission Controls GIAPCTL 7.0 (S4BT0) (riririii s isisis s sttt ttrst

Click this button.

=

Process: |

Parameter Set: EI

Printer Control

E Special Print:

Printer: ‘

Lines: ’_

Submit Time:

If the form opens in
query mode, enter

your selection _
criteria. Process: A% Title: | System: ’7@ (1
SEIeCt EXeCUte ’7 Description: | Type: -
Query_ ’_ Printer: EI Lines Per Page: ,7 Special Print Stock:

’7 validation: | Command: | Activity Date:

’7 Process: Title: | System: ’_F

’7 Description: Type: g

’_ Printer: ] Lines Per Page: ,7 special Print Stock:

Validation: command: | Activity Date:

. 7= intenance G14
Submiss  pegerip
Printer
["'save Pa )
Validat  ppocags: Title: [Membership Acknow, Process system: o [7] =
T oam— Description: ‘Membersmp Acknowledgernent Process Type: ‘PRO*C '|
Process Name o o = Y o
Record: 171 Printer: 2] Lines Per Page: 35 Special Print Stock: | it
Proces:  yajidation: [ Command: | Activity Date: |z3-Fes-zoon
Descrip
The form displays Piiter
matChlng values. Process: ABPADIS Title: ‘Dues Adjustment Report System: |a [v]
Description:  |Dues Adjustrnent Report Type: ‘FRD*C v|
Printer: E[ Lines Per Page: 54 Special Print Stock:
Validation: Command: ‘ Activity Date: 09-MAR-2000
Entera que
Record: 11
Process: AAPCARD Title: ‘Memhershlp Card Process system: |a [¥]

Scroll (if necessary) to the value
you want. (The selected record is

high"ghted.) Double-click. Process: AAPFEED Title: [advancement Dues-Finance Feed System: 4 [7]
Description:  [Feeds dues payments and adiustments to finance, Type: [PRo*C -
Printer: 7@ Lines Per Page: ’? Special Print Stock:
validation: command: ‘ Activity Date: m =

Processm

[Membership Gard Initiation Pracess

[ 2

Lines Per Page:

vatidation:

Type: ‘PRO*C

Special Print Stock:

Command: [

Activity Date: |29-DEC-1993

Entering IDs

Process Name, Process may be Pro*C, Executable, Procedure or Oracle Report.

Record: 17 |

| | <osc-

Many Banner forms have ID fields for persons and non-persons. For example, .

There are several ways to enter an ID:
» Enter a complete ID.
 Enter a complete name.
» Search by partial ID.

 Search by partial name.
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» Search by SSN (U.S.), SIN (Canada), TFN (entities), or birth date.
» Use a product-specific search form.

 Search by the pattern of characters in the name (Oracle Soundex).
To enter a complete ID:
1. Enter the full ID (for example, 2314780) in the ID field.

2. Press Enter. The ID and name appear.

To enter a complete name:
1. Make sure the ID field is blank.
2. Tab to the Name field (unlabeled field next to the ID field).

3. Enter the full name.

The format is last, first, middle with a comma between each part of the name. Spaces
between each piece are optional. Characters can be upper or lower case. (You get the
same results whether you enter upper or lower case letters.)

Examples:

Smith, Thomas, James
Smith, Thomas (no middle name)

4. Press Enter.

« |f one match is found, the ID and name are returned to the form.

« |f more than one match is found, the ID and Name Extended Search window
appears. You can select an ID (see “To select an ID from the ID and Name
Extended Search window™), reduce your search (see “To reduce your search
in the ID and Name Extended Search window™), or access a product-specific
search form (see “To access a search form from the ID and Name Extended
Search window™).

To search by partial ID:

1. Enter a partial ID in the ID field. Use the Oracle wildcard % to represent any number
of unspecified characters.

Example:
Enter 21% to search for all IDs that start with “21”.

2. Press Enter.

« |If one match is found, the ID and name are returned to the form.
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* If more than one match is found, the ID and Name Extended Search window
appears. You can select an ID (see “To select an ID from the ID and Name
Extended Search window” in this chapter), reduce your search (see “To
reduce your search in the ID and Name Extended Search window” in this
chapter), or access a product-specific search form (see “To access a search
form from the ID and Name Extended Search window” in this chapter).

To search by partial name:
1. Make sure the ID field is blank.
2. Tab to the Name field (unlabeled field next to the ID field).

3. Enter a partial name.

The format is last, first, middle with a comma between each part of the name. Spaces
between each piece are optional. Characters can be upper or lower case. (You get the
same results whether you enter upper or lower case letters.) Use the Oracle wildcard
% to represent any number of unspecified characters.

Examples:

Enter smith,J% to search for all IDs with the last name “Smith” and first names that
start with “J”.

Enter mag%,p% to search for all IDs with last names that start with “Mag” and first
names that start with “P”.

Enter ,Barbara to search for all IDs with the first name “Barbara”.

> Note
The underscore ( _ ) wildcard cannot be used to search in the Name
field. m

4. Press Enter.
« |If one match is found, the ID and name are returned to the form.

* If more than one match is found, the ID and Name Extended Search window
appears. You can select an ID (see “To select an ID from the ID and Name
Extended Search window” in this chapter), reduce your search (see “To
reduce your search in the ID and Name Extended Search window” in this
chapter), or access a product-specific search form (see “To access a search
form from the ID and Name Extended Search window” in this chapter).
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To select an ID from the ID and Name Extended Search window:

Use these steps when you search by ID or name and multiple matches are displayed on the
ID and Name Extended Search window.

1. Pull down the list of matches in the Search Results field.

> Note
Previous names and IDs are indented under the current name and ID. =

2. Scroll to the desired name and ID.

3. Click the desired name and ID. The ID and name are returned to the form.

To reduce your search in the ID and Name Extended Search window:

Use these steps when you search by ID or name and multiple matches are displayed on the
ID and Name Extended Search window.

1. Select the Person, Non-Person, or Both radio button in the Reduce Search By block
to identify the kind of IDs you want to search. The field next to the Search Results
field shows the number of matches.

2. Enter your search criteria in the fields in the Reduce Search By block.

3. Click the Search button or select Execute Query. The field next to the Search
Results field shows the number of matches.

4. (Optional) Repeat steps 2 and 3 to further reduce your search.

To access a search form from the ID and Name Extended Search window:

Use these steps when you search by ID or name and multiple matches are displayed on the
ID and Name Extended Search window.

1. Click the Person Search Detail button or the Non-Person Search Detail button. The
associated search form appears with IDs that match your original search criteria. Your
original search criteria appear at the top of the form.

Example:

If Smith, J% is your original search criteria and you select the Person Search Detail
button, the search form shows all person IDs with the last name “Smith” and first
names that start with “J.”

2. Toselectan ID, skip to step 8.
OR

To reduce your search further, go to step 3.
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9.

Select the Enter Query function. A dialog box appears.

To extend the current search, select the Extend Your Current Query button.
Information on the form is cleared. (Your original search criteria remain at the top of
the form.)

OR

To discard the current search and start over, click the Start a New Query button.
Information on the form is cleared.

Enter your search criteria in any fields on the form.

If you enter a partial field value as a search criteria, use Oracle wildcards. Use the
symbol % to represent any number of unspecified characters. Use the symbol _ to
represent one occurrence of an unspecified character. You can use both wildcards in
the same search string.

Verify the Case Sensitive Query radio buttons. Change if necessary.

Select the Execute Query function. The form shows all IDs with matching
information.

Scroll to the desired ID.

Double-click the desired ID. The ID and name are returned to the calling form.

To search by SSN (U.S.), SIN (Canada), TFN (entities) or birth date:

ID fields on some forms allow you to go to the SSN/SIN/TFN Alternate 1D Search Form
(GUIALTI) and search for an ID by SSN, SIN, TFN or birth date.

1. Click the Search button next to the ID field on a form. An Option List appears.
2. Select the alternate ID search option. The SSN/SIN/TFN Alternate ID Search Form
(GUIALTI) opens in query mode.
> Note
Other available search options depend on the specific form and are not
described here. m
3. Enter your search criteria in any fields on the search form.

If you enter a partial field value, use Oracle wildcards. Use the symbol % to represent
any number of unspecified characters. Use the symbol _ to represent one occurrence
of an unspecified character. You can use both wildcards in the same search string.

Examples:

Enter 148296890 in the SSN/SIN/TFN field to search for IDs with that SSN.
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Enter 06-JUN-1982 in the Birthdate field to search for IDs with that birth date.
4. \Verify the Case Sensitive Query radio buttons. Change if necessary.

5. Select the Execute Query function. The form shows all IDs with matching
information.

6. Scroll to the desired ID.

7. Double-click the desired ID. The ID and name are returned to the calling form.

To search by SSN in an ID field

You may be able to enter a Social Security Number (SSN) in an ID field when querying
for a person record. When you search by ID, the system first checks for an 1D record that
matches the number you entered. If no matching ID is found, the system then checks for a
matching SSN.

SSN searching is available only if all of the following conditions are met:

» The SSN Search feature is enabled for the institution. The feature is controlled by
the Enable SSN Lookup check box on the Installation Controls form (GUAINST).

 Your own Banner security setup includes permission to use the SSN search feature.
A security administrator can give you pemission by adding the SSN_SEARCH
security object to the list of Banner objects for which you have access.

» The ID field has extended ID/name search capability build into the field.
To find a person record by Social Security Number (SSN):
1. Type the SSN in an ID field that has extended search capability.

2. Press Enter.

When the matching record is found, the person’s name is displayed in the Name field,
and the person’s ID (not the SSN you entered) is displayed in the ID field.
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To use a product-specific search form:

ID fields on some forms allow you to go to a product-specific search form and search for a
person or non-person by 1D or name.

1. Click the Search button next to the ID field on a form. An Option List appears.

2. Select the option for the person or non-person search form you want to access. The
selected form opens in query mode.

[ Note

Other available search options depend on the specific form and are not
described here. [

3. Enter your search criteria in any fields on the search form.

If you enter a partial field value, use Oracle wildcards. Use the symbol % to represent
any number of unspecified characters. Use the symbol _ to represent one occurrence
of an unspecified character. You can use both wildcards in the same search string.

Examples:

Enter Carnegie in the Last Name field to search for all IDs with the last name
“Carnegie”.

Enter Chris% in the First Name field to search for all IDs with first names that start
with “Chris”.
5 Note
The underscore ( _ ) wildcard cannot be used to search in the Name
fields. u

4. Verify the Case Sensitive Query radio buttons. Change if necessary.

5. Select the Execute Query function. The form shows all IDs with matching
information.

6. Scroll to the desired ID.
7. Double-click the desired ID. The ID and name are returned to the calling form.
To search by the pattern of characters in the name (Oracle Soundex):

An added option on most search forms is the Oracle Soundex search feature. You can
search for an ID by entering a pattern of characters in the ID’s name. This feature is useful
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if you aren’t sure how to spell a name. As long as the first letter of your search string is
correct, you can retrieve names with a similar pattern of characters.

1. Click the Search button next to the ID field on a form. An Option List appears.

2. Select the option for the search form you want to access. The selected form opens in
guery mode.

> Note
Other available search options depend on the specific form and are not
described here. m

3. Select the Cancel Query function.

4. Select the Search Using “Sounds Like” option from the Option menu (or navigation
frame), or select the Next Block function. The Soundex Search window appears.

5. Enter a string of characters for the last name you want to find.

You can use upper, lower, or mixed case. You can enter as much or as little of the
name as you know. As long as the first letter is correct, the search will retrieve names
with a similar pattern of characters.

> Note
The underscore (_ ) wildcard cannot be used to search in the Name
fields. u

6. (Optional) Enter a string of characters for the first name you want to find.

7. Select the Execute Query function. The search form shows all IDs that have a
matching pattern of characters.

8. Scroll to the desired ID.

9. Double-click the desired ID. The ID and name are returned to the calling form.

Inserting New Records

Many forms contain multiple records that appear as rows. For example, an ID might have
multiple address records (billing, home, and emergency contact).

You must be careful when you insert a new record:

» Once you start entering information for a new record, you must enter all required
fields. If you change your mind, you must use Clear Record or Remove Record to
exit. You cannot click out of a required field.

» Sometimes you must save or delete a record before you can continue. The auto hint
identifies these situations.
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To insert a new record:
1. Place your cursor on an existing record.

2. Select the Insert Record function. A new blank record is inserted in the list of existing
records.

3. Enter information for the new record. Make sure you enter all required fields.

4. Select the Save function.

Data Format Recommendations

June 2008

To ensure consistent information throughout your Banner System, data should be entered
in a standard way. SunGard Higher Education recommends the following standards.

Identification (ID) Numbers

Persons Enter an identification number of your choice, or use the identification
number generated by the system on any ldentification Form
(xxxIDEN).

Non-persons Use the system-generated identification number.

Names
Upper/lower Use conventional upper- and lower-case letters.
case
Last names Do not enter spaces within prefixed last names.

Examples: MacArthur, O’Connor, VanHusen, deBolt, DuShen

Do not enter spaces within hyphenated last names.
Examples: Smith-Jones, Cochram-Ashley

First initials with Enter a period and one space between the first initial and middle name.
middle names ~ Example: R. Maureen Smith

Prefixes/ Use a period after a prefix or suffix, where applicable.
suffixes Examples: Miss, Mrs., Mr., Rev., Jr., Il
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Addresses

Pound sign If your institution uses the Banner Letter Generation module, a pound
sign (#) in addresses may affect letter processing. The pound sign is a
formatting command. Refer to the Banner General Technical
Reference Manual for details.

County Use the county codes defined on the County Code Validation Form
(STVCNTY).

State and Use the codes defined on the State/Province Code Validation Form

province (STVSTAT).

ZIP/postal code Use the standard format for the country in the address. Use the codes
defined on the ZIP/Postal Code Validation Form (GTVZIPC).

Nation Enter a nation code only if you want to include the nation when the
address is printed. Use the codes defined on the Nation Code
Validation Form (STVNATN).

Letter Generation

Paragraph Letter Generation uses the pound sign (#) and period (.) to set the
output mode back to normal. If you want a # or period to be text in your
output, then precede it with a backslash.

Dates

A setting on the Installation Control Form (GUAINST) controls how you enter dates:

If this format is selected: Enter February 5, 2002 like this:
MDY Month, Day, Year 02/05/02, 02-05-02, or 020502
DMY Day, Month, Year 05/02/02, 05-02-02, or 050202
YMD Year, Month, Day 02/02/05, 02-02-05, or 020205

Banner determines which parts of a date entry are the month, day, and year, and
automatically converts and stores the date in the DD-MON-YYYY format. Year numbers
00 through 49 are converted to 2000 through 2049. Year numbers 50 and above default to
1950 through 1999. You can override the century default.

Follow these general recommendations when you enter dates:

» Always enter two digits for the day and month. For example, enter 01 for January,
not 1.
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« If you enter only part of the date, the rest of the current date is the default.

* You can enter a date without separators (no spaces), or you can use a dash (-) or
slash (/) as separators.

Tip: You can enter any single, non-numeric character into the Date field and Banner will
automatically convert it to today’s date. For example, if you enter “a” or “g” and go to the
next field, Banner will enter today’s date as the default.

Dates in Job Submission

Use the DD-MON-YYYY or DD-MON-YY format to enter date parameters for reports
and processes run with the Process Submission Control Form (GJAPCTL).

Dates in Reports and Process Output
Some, but not all, reports include the century with the year in their output.
Dates in Query Mode

Specify all four digits for a year when you query on a date field. For example, enter 26-
JUN-2002, not 26-JUN-02. If you omit the century, zeros are entered for the century. In
this example, if you enter 26-JUN-02, Banner expands the date to 26-JUNE-0002, not 26-
JUN-2002.

Avoid Special Characters

In general, you should avoid using special characters in text fields. Characters such as the
hyphen (-), slash (/), asterisk (*), and plus sign (+) may cause confusion, for example,
because they can also represent mathematical instructions.

The pound sign (#), as noted earlier, is a formatting character in Letter Generation output.
To avoid problems with Letter Generation, do not enter a pound sign (#) in addresses.

Special characters won’t always cause immediate problems, but they represent a potential
source of complications when Banner interoperates with other systems.

The following characters should generally be avoided in text fields:
* the pound sign (#)
the slash (/)

the plus (+)

the hyphen (-)

the ampersand (&)

the at-sign (@), except in e-mail addresses
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the dollar sign (3$)

the exclamation point (1)

the comma (,)

the asterisk (*)

* the percent sign (%)

If you must use a special character, use it without any spaces before or after it:

Valid: Separated/Divorced
Invalid: Separated / Divorced

Querying Information

Querying is the process of looking to see what information is already entered in the
Banner database. You can use inquiry forms, query forms, and most application forms to
perform queries.

Some forms automatically open in query mode, usually because a large number of records
would have to be retrieved. When a form opens in query mode, Enter Query appears in
the status line. You can immediately specify search criteria to narrow the search. If a form
does not open in query mode you must put the form into query mode before you can enter
search criteria.

Query Functions

Use the following functions to perform queries:

Enter Puts the form into query mode so you can enter search criteria to see
what information is already in the database. Enter Query appears in
the status line.

Execute Searches the database and displays the first set of records that match
your search criteria. This function is enabled only if you are in query
mode.

Last Criteria Enters the criteria from your last search. You can change any of the

criteria. This function is enabled only if you are in query mode.
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Exit or Cancels the query and takes the form out of query mode.

Cancel
Note: If you aren’t in query mode, the Cancel Query button on the

toolbar exits you from the form.

Count Query Counts the number of records that match the search criteria and
Hits displays that number in the auto hint.

Fetch Next Set  Replaces the current set of displayed records with the next set of
records if more records match the search criteria than fit in the
window. This function is enabled only if you are in query mode.

To query information:

1.

Access the form you want to query.

If the form opens in query mode (Enter Query is in the status line), go directly to
step 3.

If the form does not open in query mode (Enter Query is not in the status line), select
the Enter Query function.

Enter the search criteria.

You can query information in any field that you can access. You can use the Oracle
wildcards % and _. Capitalization matters. Data is matched against the search criteria
exactly as you enter them.

Select the Execute Query function. The form displays all records that match the
search criteria.
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Make sure the form
is in query mode.

[ =
Enter the search _—/I+c

Select Execute

ZIP or
Postal Code
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[l

State or
Province

T T T e

MNation Activity Date
-

e
e
—
—
—
—
—
[ ]
—
—
—
—
—
—
—

Code Walidation GTWZIPC |

ZIP or
Postal Code

City

County

State or
Province

Nation

Activity Date

03-MAR-2004 =

03-MAR-2Z004 e

(-1 (7] [z]
00963 Caralina PR
. [o2138 Cambridas M 03-MAR-2004
The form.dlsplays o239 cambridge Ma
all matching 15419 California P 11-1AN-1995
records. 62901 Carbondale I 11-1AN-1995
63701 Cape Girardeau Mo 11-JAN-1995
T2M oL4 Calgary 16 27 21-14N-1992
T3E 6K6 Calgary 8 27 18-1AN-1995
r T T [

To change your search criteria and re-query:

Use these steps after you query information and you want to re-query with different search

criteria.

1. With the original matches displayed, select the Enter Query function. Matching
records from the previous query disappear.

2. Select the Enter Query function a second time. The original search criteria appear.

3. Revise your search criteria.

4. Select the Execute Query function. The form displays all records that match the

revised search criteria.

To query a checked check box:

1. Select the Enter Query function.

2. Select (check) the check box.

3. (Optional) Enter additional search criteria.

4. Select the Execute Query function. The form displays records that have matching
information, including a checked check box.
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To count queries:

Use these steps to determine how many records match your query criteria before you

execute the query.

1. Access the form you want to query.

2. If the form opens in query mode (Enter Query is in the status line), go directly to

step 3.

If the form does not open in query mode (Enter Query is not in the status line), select

the Enter Query function.

3. Enter the search criteria.

You can query information in any field that you can access. You can use the Oracle

wildcards % and _. Capitalization matters. Data is matched against the search criteria

exactly as you enter them.

4. Select the Count Query Hits function. The auto hint shows the number of matches.

5 Note

On some forms the Count Query Hits function is redefined to a special

function. In these cases, Count Query Hits may not
records that match your query criteria.

Wildcards

June 2008

count the number of
| |

You can use the Oracle wildcards % and _ in the search criteria:

» The character % represents any number of unspecified characters.

» The character _ represents one occurrence of an unspecified character.

The following examples illustrate the use of wildcards:

To get these results:

All entries that contain “ma”
All entries that begin with “ma”
All entries that have “ma” as the last two characters

All entries that have “m” as the second character

Enter this criteria:

%ma%
ma%
%ma

Mm%
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With experience, it becomes easier to narrow your queries to get the results you want.

5 Note
The underscore ( _ ) wildcard cannot be used to search in the Name
fields. m

Extended Queries

With extended queries, you can use SQL*Plus operators to enter more specific query
criteria.

Availability of Extended Query

Extended Query can be used only if it has been enabled for your institution, and only if
you have security permissions that include this feature.

In Oracle 10gR2, which is required for Banner 8.0, Oracle has disabled Extended Query
by default.

> Note
Security Administrators can refer to the “EXTENDED_QUERY” topic in
Chapter 1 of the Banner Security Administration Handbook for
information on how to enable Extended Query for the institution and how
to give individual users permission to use Extended Query. =

Limitations of Extended Query

The column(s) you select in an extended query must be in “base” database tables; they
cannot come from temporary work fields. For example, if you try to use the extended
query feature on the Class field (by entering a: and then selecting Execute query) on the
AOAIDEN form, it does not open the Query/Where window, but instead displays the
following message:

FRM-40301: Query caused no records to be retrieved. Re-enter.

To determine whether data is coming from a base table, you can check the item properties
on the field:

1. Choose Help>Item Properties in the menu bar.
2. Check whether the attribute called base table contains a value of TRUE' or FALSE'.

If the value is FALSE, then you will not be able to do an extended query on that field.
If the value is TRUE, then you can use the extended query feature.

June 2008



To perform an extended query:
1. Access the form you want to query.

2. If the form opens in query mode (Enter Query is in the status line), go directly to
step 3.

If the form does not open in query mode (Enter Query is not in the status line), select
the Enter Query function.

3. Move to the field where you want to use extended query.

4. Enter a colon followed by an identifying character such as A. If you are using
extended query in more than one field, enter a different character in each field (for
example, :B, :C, and :D).

5. (Optional) Enter additional search criteria.

6. Select the Execute Query function. The Query/Where window opens.

7. Enter the search criteria beginning with a colon, followed by the identifying
character, the appropriate SQL*Plus query operators, and values to match.

Example: :A>"15-SEP-02’
s Note

Due to Oracle limitations, the maximum number of search characters is
200. ]

8. Click the OK button. The form reappears with the results of the query.

> Note
The Search button in the Query/Where window controls the Oracle
Search and Replace function, not the Execute Query function. [
|
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73 Event Funetion Inguiry GEIFUNC

Enter :A as the search criteria.

Event:  AQOOS ~ wellington Advantage Winners System:  Student
Select Execute Function: E
Type: Start Date: A End Date:
. . Purpose: Invitation Date: Confirmation Date:
This window appears. Enter
. Status: Expense: Revenue: Planned Attendance:
:Afollowed by the appropriate
SQL*Plus query operators Function:
and the values to match. Type: = [ate
Purpose: mation Date:
Status: Expense: .-|ed Attendance:
Function:
Type: ate:
Purpose: ~ Fmation Date:
Status: Expense: ( ed Attendance:
Cancel Search
Click this button. —————""T Function:
Type: Start Date: End Date:
'E_E Event Function Inquiry GEIFUNC
Event: [A0005 [ [Wellington Advantage Winners System:  |Student
The form displays :
i Function:  [AFSCMEORIE [AFSCME New Employee Orientation -
a" matChIng — | Type: ORIE Start Date: 01-MAT-2004 End Date: 01-MAT-2004
records. Purpose: CPEP Invitation Date: Confirmation Date:
Status: F Expense: 10.00 Revenue: 10.00 Planned Attendance: 11
Function:  |GOLF [salf outing
Type: SFRT Start Date: 12-0CT-2004 End Date: 14-0CT-2004 i
Purpose: BLD_RELAT Invitation Date: Confirmation Date:
Status: F Expense: Revenue: Planned Attendance: 33
Function: | |
Type: Start Date: End Date:
Purpose: Invitation Date: Confirmation Date:
Status: Expense: Revenue: Planned Attendance:

Extended ID and Name Searching

The Extended Search feature provides advanced querying capabilities to help you
maintain identification information for persons and non-persons.

To use the Extended Search window:

1. Inakey block ID field, enter a partial ID and a wildcard ( % and _), or enter a partial
name in the Name field. Wildcards can also be used in the Name field, but are not
required for searching. For example, if an entire last name is entered, with no first
name or wildcards, the Extended Search window will open and the search results will
include all persons/non-persons that have that last name.

> Note
The underscore (_ ) wildcard cannot be used to search in the Name
fields. [

2. The ID and Name Extended Search window appears. The person/non-person count
displays the number of persons/non-persons returned by the search.
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3. Click the Search Results pull-down list to see the ID and name of the person/non-
persons returned from the query.

5 Note
A person/non-person may be listed multiple times in the results list if the
person has alternate names or IDs. However, each person/non-person is
only included in the count once. m

To review additional information about the persons in the search result set:
1. Click the Person Search Detail icon.

2. The Person Search form opens. The form that appears will vary by Banner product.
For example, if the searching is being performed on a Student form such as
SPAIDEN, the SOAIDEN form will open. An ID can be selected on this form. If the
ID is selected, you will be returned to the original form and this ID will display in the
key block. If no ID is selected, when you exit this form, you will return to the key
block of the original form. The Extended Search window will not redisplay
automatically.

To review additional information about the non-persons in the search result set:
1. Click the Non-Person Search Detail icon.

2. The Non-Person Search form opens. The form that is called will vary by Banner
product. For example, if the searching is being performed on a Student form such as
SPAIDEN, the SOACOMP form will open. An ID can be selected on this form. If the
ID is selected, you will be returned to the original form and this ID will display in the
key block. If no ID is selected, when you exit this form, you will return to the key
block of the original form. The Extended Search window will not redisplay
automatically.

To reduce the search to person or non-person:
1. Click the radio button for the person or non-person.

2. The results will be updated to included only persons or non-persons, depending on
your selection.

3. To reset the results to include persons and non-persons, select the Both radio button.
To reduce the search based on additional criteria:

1. Add additional search criteria in any combination of the fields: City, State or
Province, ZIP or Postal Code, Name Type, SSN/SIN/TIN, Birth Date, Gender.

2. Click the Reduce Search button.
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To clear the data from a previous search, or to enter a new query:
1. Click the Clear Search button.
To close the Extended Search window:

1. Click the X in the upper right hand corner of the window, or use keystrokes to
perform a Clear Form function.

To determine who entered the current name/ID of a non-person and the form on
which the data was entered:

1. Go to an identification form such as SPAIDEN or APAIDEN.
2. Enter the ID of the non-person you are identifying.

3. Verify that the non-person's name has been entered on the main window on the
Current Identification window.

4. Review the data in the ID and Name Source block.

To determine who entered the alternate name/ID of a non-person and the form on
which the data was entered:

1. Go to an identification form such as SPAIDEN or APAIDEN.
2. Enter the ID of the non-person you are identifying.

3. Verify that the non-person's name has been entered on the main window on the
Current Identification window.

4. Go to the Alternate Identification window.

5. Review the data in the Origin, User, Activity Date, Create User, and Create Date
fields.

Entering Basic Person Information
To enter current identification data for a person:
1. Go to an identification form such as SPAIDEN or APAIDEN.

2. Enter the ID.

> Note
If Common Matching is enabled for you, you will be directed to the
Common Matching Entry Form (GOAMTCH), where you can enter
information for the new ID and check for matches. Save the record. The
ID and associated name are displayed in the key block. |
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3. Go to the Current Identification window.

5 Note
If the person currently has a record in Banner, the system copies the
identification information and automatically places it into the fields in the
current identification block. Complete the remaining fields, following the
directions below. m

4. Enter the person's Name Type.

5. Enter the person's SSN/TIN/SIN.( This field is available on FOAIDEN and
PPAIDEN).

6. Enter the person's Last Name.

7. Enter the person's First Name.
8. Enter the person's Middle Name.
9. Enter the person's name Prefix.
10. Enter the person's name Suffix.

11. Enter the person's Marital Status. (This field is available on APAIDEN and
FOAIDEN).

12. Save.
To enter alternate identification data for a person:
1. Go to an identification form such as SPAIDEN or APAIDEN.

2. Verify the ID and the First Name, Last Name, and Middle Initial information on the
Current Identification window.

> Note
If the ID is generated, you must save the record before accessing the
Alternate Identification block. =
5 Note

If Common Matching is enabled for you, you will be directed to the
Common Matching Entry Form (GOAMTCH) where you can enter
information for the new ID and check for matches. Save the record. The
ID and associated name are displayed in the key block. u

3. Go to the next block, which takes you to the Alternate Identification window.
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4. Enter the Change of Name or ID.
5 Note
The Duplicate Record function will copy the ID or name information into
the appropriate fields on the Alternate Identification window depending on
what type of change you enter. n
5. Enter the person's alternate ID.
OR

Enter the person's alternate Last Name.
6. Enter the person's alternate First Name.
7. Enter the person's alternate Middle Name.
8. Save your changes.
To view alternate identification data for a person:
1. Go to an identification form such as SPAIDEN or APAIDEN.

2. Verify the ID and the First Name, Last Name, and Middle Name information on the
Current Identification window.

3. Go to the next block, which takes you to the Alternate Identification window.
To enter current identification data for a non-person:
1. Goto an identification form such as SPAIDEN or APAIDEN.

2. Enteran ID.

> Note
If Common Matching is enabled for you, you will be directed to the
Common Matching Entry Form (GOAMTCH) where you can enter
information for the new ID and check for matches. Save the record. The
ID and associated name are displayed in the key block. =

3. Go to the next block.
4. Enter the name of the non-person in the Non-Person Information field.

5. Save.
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To update an organization's and a person’'s name or ID:

1. Go to an identification form such as SPAIDEN or APAIDEN.
2. Go to the Current Identification window.

3. Enter the new data over the existing data.

4. Save.

5. Go to the next block (which takes you to the Alternate Identification window) to see
the changes.

AN

. OteFor updated IDs, the ID appears in the Change field. For updated names,
the name appears in the Change field. [

6. Select Next Record to view alternate names or IDs.

To delete an organization's and person's alternate name or ID:

1. Go to an identification form such as SPAIDEN or APAIDEN.

2. Select Next Record until the desired name or ID appears.

3. Select Remove Record.

4. Save. The record is no longer displayed, and it no longer exists on either the Person
Search Form (SOAIDEN) or the Non-Person Search Form (SOACOMP).

Maintaining Address and Telephone Information
To enter address information for a person:
1. Go to an identification form such as SPAIDEN or APAIDEN.
2. Enter the ID.

3. Verify that the person's First Name and Last Name have been entered on the main
window in the Current Identification tab.

4. Go to the Address window.

> Note
If the person currently has a record in Banner, the system displays the
address information on the Address window. You can insert new
information by selecting Insert Record. Complete the remaining fields,
following the directions below. m
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5. Enter the Type code for a new address.
OR

Select an address to be modified from the group of addresses previously entered for
the person.

6. Enter the street address portion of the address in the Address fields. The first field is
required. The remaining fields of the address are optional.

7. Enter the City (required), State or Province, and ZIP or Postal Code portion of the
address.

OR

Search to select a City, ZIP or Postal Code, and State or Province from the ZIP or
Postal Code Validation Form (GTVZIPC).

> Note
If the city and state are both blank and a ZIP or postal code is entered, the

city and state will default into those fields from GTVZIPC. |

8. Enter the Nation code portion of the address.

> Note
You must enter either the State /Province code or the Nation code. m

9. If you do not want to create bar codes for the address, go to the last step.
OR

If you want to create bar codes for the addresses, go to the next step.
10. Select the ZIP/PC field, and open the Delivery Information window.
11. Enter all available delivery information.
12. Return to the Address window.

13. (Optional) Enter the Phone number associated with the Address.

14. Save.
> Note
A person must have at least one complete address. [
|
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To enter address information for a non-person:
1. Access an ldentification Form (%IDEN).
2. Enter the ID of the non-person you are identifying.

3. Verify the non-person’'s Name field entry have been entered on the Current
Identification window.

4. Go to the Address window.

5. Enter the Type code for a new address.

Alternatively, you can select an address to be modified from the group of addresses
previously entered for the person.

6. Enter the street address portion of the address in the Address fields. The first field is
required. The remaining fields of the address are optional.

7. Enter the City (required), State or Province, and ZIP or Postal Code portion of the
address.

OR

Search to select a City, ZIP or Postal Code, and State or Province from the ZIP or
Postal Code Validation Form (GTVZIPC).

> Note
If the city and state are both blank and a ZIP or postal code is entered, the
city and state will default into those fields from GTVZIPC. [

8. Enter the Nation code portion of the address.

b Note
You must enter either the State/Province code or the Nation code. [

9. If you do not want to create bar codes for the address, go to step 13.

If you want to create bar codes for the addresses, go to step 10.
10. Select the ZIP/Postal Code field, and go to the Delivery Information window.
11. Enter all available delivery information.
12. Return to the Address window.
13. (Optional) Enter the Telephone number associated with the address.

14. Save.
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To enter a primary telephone number with a new address:

1.

o

Go to an identification form such as SPAIDEN or APAIDEN.
Enter the ID.

Go to the next block.

Go to the Address window.

Enter the Type code for the new address.

Enter the street address portion of the address in the Address fields. The first field is
required. The remaining fields of the address are optional.

Enter the City (required), State or Province, and ZIP or Postal Code portion of the
address.

Alternatively, you can search to select a City, ZIP or Postal Code, and State or
Province from the ZIP or Postal Code Validation Form (GTVZIPC).

% Note

If the city and state are both blank and a ZIP or postal code is entered, the
city and state will default into those fields from GTVZIPC. [

Enter the Nation Code portion of the address.

[ Note

=

9.

You must enter either the State/Province code or the Nation code. [ ]

Enter the area code, basic number, and the extension in the Telephone fields.

10. Enter the Telephone Type.

b Note

Telephone types are associated with address types on the Address Type
Code Validation Form (STVATYP). The telephone type associated with
the address type defaults, but can be overwritten. =

11. Save.

5 Note

Telephone numbers entered on the Address window are automatically
associated with an address. m

To add a primary telephone number to an existing address:

You can associate a primary telephone number with an address by using either the Address
window or the Telephone window. Keep in mind that when you associate a telephone
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number with an address, the telephone number will become inactive if you designate the
address inactive at some point.

To use the Address window:

1. Goto an identification form such as SPAIDEN or APAIDEN.

Enter an ID in the ID field. Go to the next block.

N

3. Go to the Address window.
4. Enter an address and address type, or query for an existing one that you want to use.
5. Choose the Telephone Type.
5 Note
Telephone types are associated with address types on the Address Type
Code Validation Form (STVATYP). The telephone type associated with
the address type defaults, but can be overwritten. |
6. Enter the telephone number in the Telephone field.
7. Save.
To use the Telephone window:

1. Goto an identification form such as SPAIDEN or APAIDEN.

Enter an ID in the ID field. Go to the next block.

N

3. Go to the Telephone window.

4. Choose a Telephone Type.

b Note
Telephone types are associated with address types on the Address Type
Code Validation Form (STVATYP). The telephone type associated with
the address type defaults, but can be overwritten. =

5. Enter the telephone number in either the Telephone field or the International Access
field. For international numbers, enter the entire telephone number, including the
international code.

6. Choose an Address Type and Sequence Number. You can query to find the address
type and sequence number that identifies the address you want to use.

7. Save.
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To enter atelephone number without an address:

1.

6.

Go to an identification form such as SPAIDEN or APAIDEN.

Enter an ID in the ID field. Go to the next block.

Go to the Telephone window.

Choose a Telephone Type.

Enter the telephone number in either the Telephone field or the International Access
field. For international numbers, enter the entire telephone number, including the

international code.

Save.

To make an address inactive:

1. Go to an identification form such as SPAIDEN or APAIDEN.

2. Enteran ID in the ID field. Go to the next block.

3. Go to the Address window.

4. Choose the address you want to inactivate.

5. Check the Inactivate check box.

6. Save.

b Note
When you inactivate an address, then the telephone number for that
address will also be designated as inactive. If you want to keep the
telephone number active, do one of the following: =

* On the Telephone window, uncheck the Inactivate check box for the
telephone number.

* On the Address window, choose To and From Dates to specify the active
dates for the address, instead of checking the Inactivate check box for the
address.

* On the Telephone window, do not associate an address type with the
telephone number. If an address type is already specified, then delete it.

s Note
For telephone numbers entered on the Address window of Banner Self-
Service, the address type and sequence number specified on the window
are always automatically associated with the telephone number in
Banner. [
|
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Date Queries

Date queries require special care.

Centuries in the Year

You must specify all four digits for a year when you query on a date field. For example,
enter 26-JUN-2002, not 26-JUN-02. If you omit the century, zeros are entered for the
century. In this example, if you enter 26-JUN-02, Banner expands the date to 26-JUNE-
0002, not 26-JUN-2002.

Dates and Time Stamps

Banner stores most dates with a time stamp. You don’t see the time stamp, but it’s part of
the date record and can affect the results of a query.

When you include a date in your query criteria, Banner often adds the time 00:00:00 to
the query criteria. You probably won’t get any matches with this timestamp, resulting in
the message Query caused no records to be retrieved. Re-enter.

To get the results you want, use one of these methods to enter the search criteria:

» Use a relational operator with an earlier or later date. For example, to find records
dated 26-JUN-2002, enter >25-JUN-2002 and < 27-JUN-2002. The query results
will include all records dated after June 25 and before June 27.

» Use an extended query. In the Query/Where window, use a two-digit year (for
example, 02 rather than 2002). For more information on extended query, see
"Extended Queries" on 3-32.

» Use the TRUNC function. The query :A>'15-SEP-02" will return all rows that have
an activity date (or some other date) of 15 September 2002. However, to find a
row(s) that occurs on one date, you need to use the TRUNC function as follows:

TRUNC(:A) = "05-MAY-2004"

Viewing Job Submission Output

You can view Job Submission output online with the Saved Output Review Form
(GJIREVO):

» The .10g file contains technical details about running the report or process.
» The .1is file contains the report output.

» The .doc file (for mail merges) can be viewed for the Letter Generation Print
Report (GLRLETR).
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These files can be written to the database, if so requested, and can also be displayed or
saved to your local desktop machine.

To view, save, and print output:

1.

Use the Process Submission Control Form (GJAPCTL) to run the report or process as
usual. Enter DATABASE in the Printer field.

Access the Saved Output Review Form (GJIREVO). The form shows the Process and
Number of the report or process just run.

Double-click the File Name field (or use the button) to display a list of the files that
were created.

Choose the file you want to display. Click OK. The output appears in your Banner
window.

(Optional) If you want to view the output in a browser window:

5.1. Select Show Documents (Save and Print File) from the Options menu. A dialog
box asks if you want to continue.

5.2. Click the Yes button. The output appears in a browser window.

A Note

=

Your site administrator must set up the Web URL needed to view output in
a browser window. [

(Optional) To save the output, use the browser File>Save As option.

(Optional) To print the output:

7.1. If you have not already done so, use the browser File>Save As option to save
the outpult.

7.2.  Open the saved output.

7.3. Use the File>Print option to print the output.

Accounts Receivable

Extract details with or without key data: Extract details only:
TFADETL TGACPSV
TGIACCD TSAAREV
TSASBRL
|
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Advancement

Extract details with or without key data:

Extract details only:

AGCDESG
AGCGADJ
AGCGIFT
AGCPADJ
AGCPLDG
ADAGIFT
APACLUB
APACOMB
APAEXRS
APAFHIS
APAIGRP
SOAHOLD

Finance

Extract details with or without key data:

AAAMBDP
AAAMBRL
AFCCAMP
AGAADJR
AGACTRL
AGAMGIF
AMCSTGY
APAACTY
APADCDP
APAGHIS
ASCSORG
AUAIGRP
SLABQRY
SLQEVNT

Extract details only:

FGITBAL
FIASPND
FOATEXT
FRABUDP
FRIBUDT
FRIBUTG
FRIEVNG
FRIEVNP
FRIGSUM
SOAHOLD

FEREDIC
FFAFDEL
FFASYSC
FGIBAVL
FGIBDST
FOA1099
FOASYSC
FRIBUDG
FRIBUDP
FRIGRNT
FRIPROP
FTMACCI
FTMACCT
FTMACTV
FTMCOAS
FTMLOCN
SLABQRY
SLQEVNT
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Financial Aid

Human Resources

Extract details with or without key data:

Extract details with or without key data: Extract details only:
RCRDTSR
General
Extract details with or without key data: Extract details only:
GJAPDEF GJAJOBS
GLAEXTR GLIOBJT
GLIEXTR GOAADRL
GLISLCT GOAFBPR
GLIVRBL GORDMCL
GUALETR GORDMSK
GUAOPTM GORFDMN
GUAPARA GORFDPI
GUIMAIL GORFDPL
SOAHOLD GORFDTP
GUAOBJS
SLABQRY
SLQEVNT

Extract details only:

NBAPOSN NBAFISC
NBIBHSC NBQPOSN
NBIBHSF NTRAUSG
NBIBHSP NTRFINI
NBIBHSR NTRFRNG
NBIBTOT NTRHROL
NBIPINC NTRSGRP
NBIPORG PTRBCAT
NBIWKSH PTRCALN
NHIDIST PTRETHN
NHIEDST PTRSKIL
NOIEMSG PTRSKLV
NTRAPTY PTRUSER
NTRBROL SLABQRY
NTRFBLD SLQEVNT
NTRPCLS
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Extract details with or without key data:

Extract details only:

NTRROUT
NTRWKSH
PDAFLEX
PDIDLST
PEAFDED
PEALEAV
PEAJACT
PEAJFAC
PEAPADV
PEAXJOB
PEIDTOT
PEILHIS
PHADSUM
PHAMTIM
PHATIME
PHIDERR
PHIETIM
PHITTOT
PTRBDCA
PTREARN
PTRECLS
PTRSHFT
PXAASCD
SOAHOLD

Student

Extract details with or without key data:

Extract details only:

SFAFAUD SFAREGQ
SFARCTT SFAREGS
SFARGFE SHACRMQ
SFASLST SHARQTC
SHACRSE SHARQTS
SIAASGQ SLABQRY
SOAHOLD SLQEVNT
SOAXREF SMACACT
SRASUMI SOAATRM
SOACCOL
SOILCUR
SORCACT
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3-50

Extract results are unpredictable on forms that have not been tested with this feature. If
you want to extract data on an untested form, your system administrator can consider
enabling the extract feature on GUAOBJS. SunGard Higher Education does not support
this feature on untested forms, but will, however, continue to test more forms and expand
support with future releases.

You can tell that the extract feature is enabled on a specific form if one or both of the
following options is enabled in the Help pull-down menu for the form:

» Extract Data with Key extracts details in the current block with key data.

» Extract Data No Key extracts details in the current block without key data.

The Data Extract Option field on GUAOBJS determines whether one, both, or neither of
these extract options is available for a form.

Extracting Data

Extracted data can be saved to a file with a .csv extension, or displayed as text in a new
browser window, depending upon what is set up on the Directory Options window of the
General User Preferences Maintenance Form (GUAUPRF).

Generally, your site administrator specifies a value for the entire institution, but you may
have the option to set your own preference. If you do, then you can use the following steps
to specify your preference.

To specify your preference for extracting data:
1. Access the General User Preferences Maintenance Form (GUAUPRF).
2. Go to the Directory Options window.

3. Scroll to the record where Description is Data extract format: FILE (.csv) , TEXT, or
WEBUTIL.

4. If you want your extracted data to be placed into a file in comma separated value
format (with a .csv extension), enter FILE in the User Value field. When you extract
data, you will be prompted to save it to your local drive.

OR

If you want your extracted data to be displayed in a separate browser window, enter
TEXT. The information is display-only, but you can save it in a variety of formats.

OR
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If your institution uses the WebULtil option, you can enter WEBUTIL to save the .csv
file to your local drive using the General WebUtil File Extract Form (GUQWUTL).

> Note
Before using the WebUtil option, ensure that your institution has
configured it. m

5. (Optional) If your institution uses the WebUtil option, you can specify a default
directory to save your output in the User Value field for the Local directory for
saving output record.

6. Save.

To perform a data extract:

1. Access the Banner form.

2. If applicable, display the desired records on the form.

3. Select one of the following options from the Help pull-down menu:
« Extract Data with Key (to extract key data and data in the current block)

« Extract Data No Key (to extract data in the current block only)

Extracted data is displayed in a browser window, or you are prompted to save the
output file, depending on which option is specified on the General User Preferences
Maintenance Form (GUAUPREF).

Tip: To save the data from your browser window to a file, use Internet Explorer’s
File>Save As option to save the extracted data to a local directory as a .txt file. Then
rename the file asa .csv file.

OR

For Netscsape, use the browser’s File>Save As option to save the extracted data to a
local directory as a .csv file.
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Using the Calendar

Features of Banner

muo .

Double-click

this field.

File Edit Options Block Item Record Query Tools Window Help

i 7.0 (s54b70) ©

BOAE CHEEER ¥ BEME G S EE D g

L@ X

Recipient: E Sender: Date: @ Time:
Message: ‘ @ source:
Reference ID: ‘ E” Ttem:
System: ’_E
C Complete ® pending ( Hold | confidential
Recipient: [7 Sender: Date: [_g, Time:
Message: ‘ 7 source:
Reference ID: ‘ [7| Item:
System: [T+
O Complete © Pending C Hold
Recipient: F
Message: ‘ R,
Reference ID: | o JANUARY 2005 >> |
System: ’_F
Ocomplete  Opending  Cuod O | suM | [mon | [Tue | [wep | [tHu | [ PRI [ =aT
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[16 | [ 27 [[28 |[ 29 | [ 20 |2t ][22
[23 || 24 |[25 || 26 || 27 || 28 | | 29
[0 ] [= | [ (NN N [ |

The calendar appears.

Double-click any date on the calendar to
return it to the Date field on the form.

» Double-click any date field, or click the Calendar button. If the date field has a

) o)

There are three ways to display the calendar:

value, the calendar highlights that date. If the date field is empty, the calendar
highlights the current date. You can double-click a date on the calendar to return it

to the calling form.

» Use Direct Access to display the Calendar Form (GUACALN). When accessed this

way, the calendar works independently of any form or field. You cannot select a

date and return it to a form.

....
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 Select Help>Calendar. When accessed this way, the calendar works independently
of any form or field. You cannot select a date and return it to a form.

Using the Calculator

There are three ways to display the calculator:

» Double-click any numeric field, or click the Calculator button. If the numeric field
has a value, the calculator shows that value. You can use the mouse, number keys
on the keyboard, or the numeric keypad (if the NumLock is enabled) to make
calculations. When you’re done, click the OK button to return the calculated value
to the calling form.

» Use Direct Access to display the Calculator Form (GUACALC). When accessed
this way, the calculator works independently of any form or field. You cannot
return a calculation to a form.

 Select Help>Calculator. When accessed this way, the calculator works
independently of any form or field. You cannot return a calculation to a form.

Code

Budget Amount Actual Amount Difference Revenue Date

& =]
[ ] | | |

[ | | | |

[ | | | |

Totals: ‘ ‘ |

S

Double-click this field.

The calculator
’_ Clear Delete

@EEEE D | Moy
@EDE J@

ey o) [0 O = ) ) )
= ‘-‘ |J — Click this button to return the calculated

(—Oﬁ P value to the numeric field on the form.
[ |
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Using Help

Banner has several kinds of help that can give you immediate online assistance:

Online help. This is online information about forms and fields as well as tasks you
can perform with Banner.

Local Dynamic Help. This format enables you to store your own information for
fields, blocks, and forms.

Banner Documentation Bookshelf. This tool lets you access Banner documents
directly from your computer by using a desktop shortcut. These electronic
documents look the same as the hard copy versions, regardless of the computer you
are using.

Help (Item Properties). This list shows all the properties of the field where the
cursor is currently located.

Show Keys. This list shows the Oracle functions and associated keystrokes
available in your environment for the field, window, and form where the cursor is
currently located.

Auto hint. This hint at the bottom of the form briefly describes the field where the
cursor is located. Error and processing messages also appear here.

Online Help

June 2008

Banner online help contains information about forms and fields, as well as tasks you can
perform with Banner. This help system runs in a web browser.

Installation and configuration information is contained in the Banner Middle Tier
Implementation Guide. These activities are performed by your site administrator.

Accessing Online Help for a Form

When you access online help, information about the current form is displayed. From there,
you can expand the help window to browse through other topics, or to use the search and
index features to look for specific topics.
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2} Survey Definition Form (GUASRYY] - Microsoft Intemnet Explorer

J File Edit ‘“iew Favoites Toos Help ?

JOBackva D @ ;/h|pSean:h *Favnntes @|B'&'D vl el é% 3 JLinks

Click this button to
expand the help 0 | Banner Help Center

system. =

General : WWeb Management Forms : Forms © Survey Definition Form (GUASRYY)

Survey Definition Form (GUASRVY)
Use this form to define the following information for a survey:

* Whether the survey appears on the Web

* Date range when the survey appears on the \Web

* Description that appears on the Wweb

® Questions and valid responses in the survey

* Web products and populations that can access the survey

rain Window

Use this window to describe the survey and optionally to identify a population of Banner IDs that
can respond to the survey.

Flalds Descriptions
Survey Name of the survey. The maximum length is 15 k|
@ Done ’_I_I_’_’_ @ Trusted sites v

To display online help for a form:

D

1. Click the Online Help button in the 1. Select Help>Online Help.
toolbar.

Browsing for Topics

The Contents tab and the bread crumb trail both enable you to browse for topics
categorically. Form and field information is organized by Banner module. Task
information is contained under the Procedures heading.
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Browsing with the Contents tab

a Population Selection - Microsoft Intemnet Explorer

J Fle Edit “iew Favoites Tool: Help ?

JeEack - O - @ @ :{:j|pSearch *Favontes @| 8' i} - D ?‘ ﬁ é% ..ﬂ JLinks
J Banner Help Center

L:@ General

mIPrDCBdUrES General - Procedures © Population Selection Procedures - Copying a Population Selection
@ Introduction
QJUIJ Submission Procedures
([ Populstion Selection Procedures
[g] Definitions
@ Building a Population Selection

Copying a Population Selection

[2] Copying a Population Selection ¥ou can copy the rules in an existing population selection to create
[2] creating a Papulation with GLEDATS a new population selection, You can change the application and
[2] creating & Manual Population selection ID, Your ID becomes the creator ID. A copied population _
@ Letter Generation Procedures selection can be changed as needed.
@ Systern Functions/adrministration Proce —
@ Event Management Procedures 1. Access the Population Selection Definition Rules Farm
@ General Internatianal Management Pras (GLRSLCT).
@ Business Rule Builder Procedures . . . . . .
@ Multi-Institution Functionality (MIF) Prac 2, Enter the application associated with the population selection

@ Basic Person Procedures you want to copy in the Application field.

eThe Cammon Matching Process

@ The algorithm 3. Enter the population selection you want to copy in the

Setup for Protecting Sensitive Dat Selection ID field. You can select the down arrow icon to
Q?| AE:ID ?:r reieeing sEnsfive b = access the Population Selection Inguiry Form (GLISLCT) to
4 S e | ’ search for a population selection. B

@ e

Searching for Topics

The Search tab allows you to search for topics within the help system. You can also use
your browser’s “search on page” feature to find specific text on a help page.

Searching with the Search tab

1P/Postal Code Yalidation Form [GTYZIPC] - Microzoft Internet Explorer

J File Edit “iew Favoites Toole Help ?
JeBack - O - @ @ Zh|p55alch *Favorites ®| ﬁ' Q} - D y ﬁ é% .'ﬂ JLinks

Banner Help Center

Contents

General @ System Functions Farms @ Forms @ ZIP/Postal Code Validation Form

Rank Title
100, Menu Mavigation Table
30, wvalidation Forme ZIP/Postal Code Validation Form ((gRFS1e)
30, Walidation Forms Reference
7. Common Matching Entry Form Use this form to identify the ZIP codes and postal codes used
(GOAMTCH) throughout Banner. ¥ou can assign ZIP/postal codes to:
7. Menu Mavigation Table
7. Malidation Forms * Sites on the Site Code Yalidation Form {STYSITE).
7. (Zéfr’:fpznlssacl)cnde Validation Form + Buildings on the Building Definition Form {SLABLDG).
7. ZIP/Fostal Code Validation Form * Recruits on the Quick Recruit Form {SRAQUIK).
(STVZIPC) * Donors on the Gift Form (AGAGIFT).

Defining ZIP/postal codes on this form can help you enter addresses
in Banner more accurately. If you are on application form and select
a ZIP/postal code from a List of Yalues, address data from [ C
automatically appears in the associated fields on the form.

=l
Elooe N X
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Using the Index

The Index tab provides an alphabetical listing of topics within the help system. Click on a
letter in the index to scroll through topics that begin with that letter.

Searching with the Index tab

@ Defining New Reports and Processes to Job Submission - Microsoft Internet Explorer

J File Edit “iew Favoites Toolz Help ?

JeBackvO e @ @ :_/;j|/o55arch ‘i‘\?Favontes @| 8'& v D ‘:;Yﬁ é% .“3 JLlnks

C EFGHIIJILMMNDOPOGQR
U ¥ W Z Symbols

Banner Help Center

A B
s T
General : Procedures @ Job Submission Procedures : Defining Mew Repaorts and Processes to

Duata Display Mask Columns Data Dictionary 2] Job Submission

Data Display Mask Caolurnns Form {GORDMCL)
Data Display Mask Rules Form {SORDMSK)
data extract
dates

format masks Defining New Reports and Processes to Job Submission
Day of week Validation Form (STYDAYTS)
Default Parameter Yalue Validation Form (GIAPC
defining a new bank code

1. Use the Process Maintenance Form (GJAJOBS) to define the
characteristics of the report or process.

defining

New processes

new reports Note: If the code for the process is not written in RPT or

variable with a first variable type — Pro C, you may need to modify the gjajobs procedurs

variables ) (gjajobs.shl or gjajobs.com) to submit jobs from the |
Dearee Code Wslidation Form (STVDEGC) Process Submission Control Form (GIAPCTL).

deleting Visa records
Departrment Code Validation Form {STWDEPT)

Departrnental Hanors Code Walidation Form (ST 2, Use the Parameter Definitions Form (GJAPDEF) to define the

Desktop Tools - Add-In Application Form (GOAD characteristics and validation requirements of the parameters for

Desktop Tools - Add-In VYalidation Form (GTWD& the report or process. Optionally, you can establish system-level

Desktop Tools - Step Property Walidation Form defaults,

Desktop Tools - Step Property Walues Rule For:ﬂl_v|

4 L 3. Far narameters that cannnt he validated b an existinn =l
[&] Dore 0T T @ Trustedssies v

Accessing the Help Center

If you want information about forms and tasks for another Banner product, use the Help
Center link, which is available from the main menu of Banner, or from anywhere within
the help system.

From the Main Menu

Products: [+ Menu | Site Ma Help Center

My Links

From Within the Help System

Banner Help Center

General : Procedures © Job Submission Procedures
Job Submission

Frocedures
Reports and Processes
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From either the main menu or within the help system, the Help Center appears:

a Banner Help Center - Microsoft Internet Explorer =] '
J File Edit “iew Favoites Toolz Help | ?

JGBackva %] &) ’\’{h|pSearch 5% Fevorites @‘B-,}}-D A8

®  SUNGARD HIGHER EDUCATION

Banner Help Center

Accounts Receivable
General
Advancement
Hurman Resources
Student

Finance

Financial Aid

BxS

d. The unau e,
material ar ] ntained herein iz
o
@ l_ l_ l_ l_ l_ g My Computer 4

O Note
Only products that are licensed at your site appear on the Help Center
page. [

To display the Help Center

D
1. Click the Help Center link on the 1. Use the Tab key to navigate to the
main menu, or click the Banner Help Banner Help Center link within the
Center link within the help system. help system.

2. Press the Enter key.

Local Dynamic Help

This help is completely written and maintained by your institution. System upgrades do
not affect this help text. It is the default when you access Dynamic Help.

Local Dynamic Help is displayed on the Help Form (GUAHELP). You can access
GUAHELP in query mode or edit mode.
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You can use the main window of GUAHELP to identify the help text you want to access.
A check box tells you if the requested item has help text.

. F GEAFUNC ] . e
Choose Dynamic Help B'I’:; IKEY — - Identlfy.the specific item whose
for a form, block, or field. i = — Dynamic Help you are
® Field [sLaEvNT_cRN =]
Banner ® Local

"""""""" \ This checkbox indicates whether
Choose Banner Dynamic Help i | the requested Dynamic Help exists.

or Local Dynamic Help.

( Display )( Clear JJ( Cancel J

When you first access the main window, the selection criteria indicate Local Dynamic
Help for the field where the cursor is located. Banner internal item names identify the
current form, block, and field.

You can override the defaults and access help text for another form, block, or field. For
Local Dynamic Help, you can create block and field names that make sense to your
institution. (Banner does not define the names.) Once you create a name, you must always
use that name to access Local Dynamic Help for the item. SunGard Higher Education
recommends that you use the Banner-defined names for all your Banner-delivered forms.

To access Dynamic Help in query mode:

RS &

1. Press Shift and double-click a field. 1. Select Help>Dynamic Help Query.
The Help Form (GUAHELP) appears. The Help Form (GUAHELP) appears.
The default selection criteria indicate The default selection criteria indicate
Local Dynamic Help for the field you Local Dynamic Help for the current
clicked. field.

2. Verify the default selection criteria. 2. Verify the default selection criteria.
Change if necessary. Change if necessary.

3. Click the Display button. The Help 3. Select the Next Block function. The
Text window shows help text for the Help Text window shows help text for
requested item. the requested item.

To access Dynamic Help in edit mode:

1. Select Help>Dynamic Help Edit. The Help Form (GUAHELP) appears. The default
selection criteria indicate Local Dynamic Help for the current field.

2. Verify the default selection criteria. Change if necessary.

Banner General 8.0 June 2008
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3.

Select the Edit button or the Next Block function. The Help Text window shows help
text for the requested item.

To override the defaults and access Dynamic Help for another item:

1.

Access Dynamic Help in either query mode or edit mode. The default selection
criteria on the Help Form (GUAHELP) indicate Local Dynamic Help for the current
field.

To access help text for another form, choose the Form radio button and enter the
form name.

OR

To access help text for another block, choose the Block radio button and enter the
form and block names.

OR

To access help text for another field, choose the Field radio button and enter the form,
block, and field names.

Select the radio button for the type of Dynamic Help you want to access (Banner
Dynamic Help or Local Dynamic Help).

Select the Display button (query mode), Edit button (edit mode), or Next Block
function. The Help Text window shows help text for the requested item.

To choose a block or field name from an LOV:

Use these steps if you don’t know the block or field name of the Dynamic Help you want
to display. You can display an LOV that lists all the blocks or fields on the form that have
Dynamic Help.

If you display Banner Dynamic Help, the LOV shows internal item names. If you display
Local Dynamic Help, the LOV shows the names you assigned.
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Access the Help Form (GUAHELP).

Access the Help Form (GUAHELP).

Click the Banner or Local radio 2. Select the Banner or Local radio
button on the main window. button on the main window.
Verify the form name. Change if 3. Verify the form name. Change if
necessary. necessary.
For block names, click the Search 4. For block names, select the Next Item
button on the Block field. An LOV function until you reach the Block
appears. field.
OR OR
For field names, verify the block For field names, verify the block
name. Then click the Search button on name. Then select the Next Item
the Field field. An LOV appears. function until you reach the Field
field.

Scroll to the desired name.

5. Select the List function. An LOV
Double-click the name. The selected appears.
name is returned to GUAHELP.

6. Scroll to the desired name.

7. Press Enter. The selected name is

To enter or update Dynamic Help:

returned to GUAHELP.

1. Select Help> Dynamic Help Edit. The Help Form (GUAHELP) appears. The default

selection criteria indicate Local Dynamic Help for the current field.

Verify the default selection criteria. Change if necessary.

Select the Edit button or the Next Block function. The Help Text window shows help

text for the requested item.

Enter your changes in the Help Text window.

You can use the Editor to modify text. See "Using the Editor" in chapter 4. You can
search for a specific string of characters or replace a string of characters with another

string (instructions follow).

Select the OK button in the Help Text window. The GUAHELP main window

appears.

Banner General 8.0
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6. Select the Save function. A dialog box appears.

7. Select the OK button or press Enter.

'7E Help Form GUAHELP
' Form SPAIDEM
Cplock SPRIDEN_CURRENT Verify the selection criteria.
@ Field PERS_LAST_MAME v Change if necessary.
CBanner @ ocal Help Exists? Click this button.
Edit Clear Cancel
Help Text i7" This window
Last Name = appears. Enter
The Last Mame field is used to create or change the current last name of person associated your Changes
with the identification number. To change information, the user can type over the current here.
information.
Click this
- button.
Save.
( o] 4 ”Qancelj (5earch)

To search for a string of characters:

1. Access Dynamic Help in query mode or in edit mode. The default selection criteria
on the Help Form (GUAHELP) indicate Local Dynamic Help for the current field.

2. Verify the default selection criteria. Change if necessary.

3. Select the Edit button (edit mode), Display button (query mode), or Next block

function. The Help Text window appears.

4. Select the Search button. The Search/Replace window appears.

5. Enter the search string in the Search for field.

6. Select the Search button. The Help Text window displays the area that contains the

first occurrence of the search string.

7. (Optional) Continue selecting the Search button to find the next occurrence of the

string.

To replace a string of characters:

1. Select Help> Dynamic Help Edit. The Help Form (GUAHELP) appears. The default
selection criteria indicate Local Dynamic Help for the current field.

> Note

You must access GUAHELP in edit mode.
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2. Verify the default selection criteria. Change if necessary.

3. Select the Edit button or the Next block function. The Help Text window appears.
4. Select the Search button. The Search/Replace window appears.

5. Enter the search string in the Search for field.

6. Enter the replacement string in the Replace with field.

7. To replace the next occurrence of the string, select the Replace button. You can
continue clicking the Replace button to replace each occurrence.

OR

To replace all occurrences of the string, select the Replace All button.
8. Respond to the dialog boxes (if displayed) to continue the search.
9. Select the Cancel button on the Search/Replace window.
10. Select the OK button on the Help Text window.
11. Select the Save function on the main window. A dialog box appears.

12. Select the OK button or press Enter.

Banner Documentation Bookshelf

The Banner Documentation Bookshelf is an easy way to access Banner documents
directly from your computer. The Bookshelf includes both user and technical
documentation. Documents in the Bookshelf appear in PDF (portable document format).
They look the same as the hard copy versions, regardless of the computer you are using.
You can print any document locally.

The Bookshelf can be downloaded to a central location at your institution, making it
available for use by authorized users. Your system administrator can use the Banner
Documentation Bookshelf Gettting Started Guide to set up the Bookshelf.

In addition to the system setup, you must install Adobe Reader® on your computer. This
software is freely available from Adobe and lets you read, print, and search the PDF files
in the Bookshelf. Once you know the location of the Bookshelf at your institution, you can
create a shortcut on your desktop to access it easily.
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To create a desktop shortcut for the Bookshelf:

1.

6.

Open Windows Explorer.

Browse to the location where the Bookshelf directory is stored at your institution
(bdoc6x or bdoc7x, depending upon the version of Banner you are using).

Right click bkshlfxx.pdf and choose Create Shortcut.
Drag the shortcut to your desktop.
(Optional) Rename it.

Double-click the icon to launch the Bookshelf.

To access a specific manual and chapter:

1.

Open the Bookshelf.

In the left pane, click the bookmark in front of the product you want to access. The
bookmark expands to show the product’s documents.

If necessary, expand bookmarks in the left pane until you see the document or chapter

you want to display.

Click the name of the document or chapter you want to display. The selected
document or chapter appears in the right pane.

To set up your search preferences:

You can search for information in one or more documents. You must set up your
preferences before you can search the Bookshelf. You only need to enter these setups
once.

4,

Open the Bookshelf.

Select File>Preferences>Search to display the Acrobat Search Preferences window.

Set up your preferences.

Click the OK button.

To attach indexes for the documents you want to search:

Before you can search a document, you must attach its index. You only need to attach a
specific index once.

1.

Determine where the index files are located (file extension .pdx). They are in the
folder named _indexXx,where X is the release number. This folder is located in the
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8.

same folder as the Bookshelf files. Check with your data center personnel, if
necessary.

Open the Bookshelf.

Select Search Indexes in the left pane. The Index Selection window appears with a
list of the currently attached indexes.

Click the Add button. The Add Index window appears.

Select the index you want to attach. You may have to change directories to find it.

Click the Open button. The selected index is added to the Index Selection window.

Repeat steps 4 through 6 for each index you want to add.

Click the OK button in the Index Selection window.

To search for information:

> Note
Adobe Reader must be loaded on your computer. |

1. Open the Bookshelf.
2. Click the Search button in the Acrobat toolbar, or select Search Query in the left

pane. The Adobe Acrobat Search window opens.
3. Enter the text you want to find.
4. Click the Indexes button. The Index Selection window appears.
5. Select the manuals you want to search.
6. Click the OK button in the Index Selection window. The Index Selection window

closes.
7. Click the Search button in the Adobe Acrobat Search window.

If one file contains the requested text, the file appears. This procedure ends.

OR

If more than one file contains the requested text, the Search Results window appears

with a list of the files that contain the requested text. Continue with step 8.
8. Select the file you want to display.
9. Click the View button. The selected file appears.

|
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Help (Item Properties)

Help (Item Properties) lists all the properties of the current field. For example, you can
find its internal database name, whether it is queryable, whether it is required, type of data
(character or numeric), maximum length, and minimum and maximum values. See your
Oracle documentation for information on each item property.

To display Help (Item Properties) for a field:
1. Place the cursor in the field.

2. Select the Help (Item Properties) function.

Show Keys

Show Keys lists the Oracle functions and associated keystrokes available in your
environment for the current field, window, and form. Specific keystrokes for a function
depend on your environment.

To display Show Keys:

Select the Show Keys function.

Auto Hint

The auto hint at the bottom of the form can contain the following information for the field
where the cursor is located:

* Brief field description
 Error and processing messages

» Keyboard equivalents (if you can access other blocks, windows, or forms from the
field)

Using the Editor

June 2008

The editor is a tool that helps you enter, update, and view information in a data field. For
example, you can use the editor to enter, update, and view Dynamic Help text on the Help
Form (GUAHELP).

Some data fields are actually longer than they appear on the form. With the editor, you can
expand a data field to display a larger, freeform window where it is easier to read or enter
more data. The size of the window depends on the defined length of the field.
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To expand a data field:
1. Place the cursor in the field you want to expand.
2. Select the Edit function. A freeform window appears.
5 Note
Some data fields have a Comment button that you can click to open the

freeform window. n

To select text:

S, &

1. Click on one side of the text you want 1. Use the arrow key to move to one side
to select. of the text you want to select.

2. Drag the cursor to the other side of the 2. Hold down the Shift key as you use

text you want to select. the arrow key to move to the other
side of the text you want to select. The
3. Release the mouse button. The selected text is highlighted.

selected text is highlighted.

To insert text:

D &
1. Click where you want to insert the 1. Use the arrow key to move to where
text. you want to insert the text.
2. Enter the new text. 2. Enter the new text.

To replace text:

1. Select the text you want to replace.

2. Enter the new text. The new text replaces the existing text.
To copy text and save it on the clipboard:

1. Select the text you want to copy.

2. Select the Copy function. The text remains in its current location and is copied into an
invisible clipboard.
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To cut text and save it on the clipboard:

1.

Select the text you want to cut.

2. Select the Cut function. The text is deleted from its current location and is copied into

an invisible clipboard.

To paste text from the clipboard:

1.

2.

Place the cursor where you want to paste text.

Select the Paste function. Text from the clipboard is inserted.

To delete text:

1.

2.

Select the text you want to delete.

Press Delete.

To search for text:

9.

Expand the data field. A freeform window appears.
Select the Search button. The Search/Replace window appears.
Enter the search string in the Search for field.

Select the Search button. The window displays the area that contains the first
occurrence of the search string.

Respond to the dialog boxes (if displayed) to continue the search.
Select the Cancel button on the Search/Replace window.

Select the OK button on the freeform window.

Select the Save function on the main window. A dialog box appears.

Press Enter.

To replace text:

1.

Expand the data field. A freeform window appears.
Select the Search button. The Search/Replace window appears.
Enter the search string in the Search for field.

Enter the replacement string in the Replace with field.
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5. To replace the next occurrence of the string, select the Replace button. You can
continue clicking the Replace button to sequentially replace the next occurrence.

OR

To replace all occurrences of the string, select the Replace All button.
6. Select the Cancel button on the Search/Replace window.

7. Select the OK button on the freeform window.

Banner Messaging

If you have the appropriate security, you can send messages to and receive messages from
other Banner users. Messages are created and viewed on the General Message Form
(GUAMESG).

When you have a new message to view, a checkmark appears next to the Check Banner
Messages link on the main menu. You can select this link at any time to view messages, or
go directly to the General Message Form (GUAMESG) from another form in Banner
using Direct Access or some other method.

Broadcast Messages

In addition to individual messages, Banner has the ability to display broadcast messages
for all Banner users. These messages appear near the bottom of the main menu. When
there is a new broadcast message, the Broadcast Message button on your toolbar becomes
enabled, and takes you to the main menu when clicked.

Users whose security privileges include the BROADCAST special security object can send
broadcast messages to all users. To send a broadcast message, create it on GUAMESG as
usual, and choose BASELINE as the recipient.
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5 Customization
_

Customizing Banner

You can customize Banner to meet your individual needs. For example, you can:
 Create a personalized menu with My Banner
» Choose what information appears in title bars
* Specify whether form names are displayed on menus

» Customize the appearance of the main menu

My Banner

My Banner includes the forms, jobs, menus, and QuickFlows that are most important in
your daily work. You can access My Banner from the main menu. It is tied to your Oracle
user ID.

The following forms are used to create and copy My Banner menus:

» The My Banner Maintenance Form (GUAPMNU) lets you create and change My
Banner.

» The My Banner Maintenance and Copy Form (GUTPMNU) lets you copy a My
Banner menu to or from another user.

Making Changes to My Banner

There are several ways to add Banner objects to My Banner:
« Scroll through the object list to find what you want to add
» Enter the name of the object

» Query the object list to narrow your search

You can also delete objects from My Banner either one at a time or all at once.
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To use the object list to add an object to My Banner:
1. Access the My Banner Maintenance Form (GUAPMNU).

2. Use the pull-down list above the left pane to select the object type you want to
display. The left pane lists the objects of the selected type.

s Note
You can query to reduce the object list. See the instructions later in this
chapter. [

3. Inthe left pane, select each object you want to add to the menu by double-clicking it.

When you select an object, the name is highlighted.

4. (Optional) Repeat steps 2 and 3 for each object type you want to add to the menu.

5 Note
You can select objects from multiple object types (for example, a form and
a menu) and insert them all at one time. |

5. Click in the right pane where you want to place the new menu items.

6. Click the Insert Selection button in the middle of the form E The selected objects
are added to the right pane below the place you clicked.

N

(Optional) Change the object descriptions.

8. Save.
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Eile Edit Options Block [tem Record Query Tools Window Help

EEEE

ainte ) 1l-FE

JPIERSOL's Personal Menu

Select the object type _ .
youwant to display. — meelew /@ Object Description

GEAATTD Attendance o

Object Description

GLIAPPL application Inquiry

‘RNASLD& ‘ZDDEVZEIﬂﬁ Student Loan Data 2

‘RNASUD& ‘zuusrznnﬁ Supplemental Need Analysis

Select each object you STUSOFF [8/F/ Fund Source Validation
Want to add to the STYGSTA |A/F/I Status Validation

STUTASK |&/F/T Task Walidation
STUGTYP [A/F/1 Type Walidation
GUARBOT [About SCT Banner =
554QCRL [Academic Calendar Rule guéry /g‘
STUACCL [academic Calendar Typé validstion

STVSIZE [Academic Dress 5jz€ Validation =

Academic Dres# Type v.al/mfﬁn

SHQSUB] Academm)rémry C}Mﬁg Query

¥

(2]

ClICk In the rlght pane SHACTRL |Acadepfic H\SWDHUD\
STUEVEN | |agafemic Hfetory Event Code Validation
where yOU want to place }%m History Section Query
the new menu items. (42 AADEG ffCadermic Tnformation
SHMS Academic Non-Course M
Click this button. — fuasT0 [cademic Standing Code validation

SHASTAT |Academic Standing Query

|
File Edit Options Block Item Record Query Tools Window Help

HEEE B RHEH S

EEE R

JPIERSOL's Personal Menu

o - 2

Object Description Brcre oo o o The new menu items
(541093 [1098-T Tax Information = [sHasUB) tcademic History Catalog Query are inserted below
[Froarrve (1099 1ncame Type Cade Maintenance STVTYPE academic Dress Type Validation the cursor location.
[AA0%5 11099 Reporting GLIAPPL application Inguiry

FOA1099 |1099-MISC Magnetic Tape Transmitter D.
PXA1099 |1099-R

FTV1099 |1099-R Distribution Code Walidation

RNAOYOL |2000-2001 Applicant Override

RNRGLOL |2000-2001 INAS Global Policy Options Ru
RNIMS01 | 2000-2001 Miscellaneous Results Inquiry
RNANAOL |2000-2001 Need Analysis

RNAVROL |2000-2001 Meed Analysis Document Weri =0
RNAPRO1 |2000-2001 Meed Analysis Processing

(& [F (a]l9)

RNASLOL |2000-2001 Student Loan Data

RNASUOL |2000-2001 Supplementsl Need Analysis
RNAOYOZ |2001-2002 Applicant Override

RNRGLOZ | 2001-2002 INAS Global Policy Options RU

RNIMS0Z | 2001-2002 Miscellaneous Results Inquiry
RNANADZ |2001-2002 Need Analysis

RNAVROZ |2001-2002 Meed Analysis Document Weri

RNAPROZ |2001-2002 Meed Analysis Processing ‘ |
f r

To add an object to My Banner if you know the object’s name:

1. Access the My Banner Maintenance Form (GUAPMNU).

2. Place the cursor in a blank Object field in the right pane.

3. Enter the object’s name.

4. Press Enter. The object’s type, description, and name appear in the right pane.
5. (Optional) Change the object description.

6. Save.

June 2008 Banner General 8.0 5-3
Banner Getting Started Guide
Customization



File Edit Cptions Block ltem Record Query Tools Window Help
BOE RABE B8 BE R

’7?'_.! My Banner Maintenance MM 11-FEB :20PM

1@ X

JPIERSOL's Personal Menu

Type: [Form v @ Object Description

[cEanTTD [attendance =

Object Description

[aL1appL [application Inquiry
[tsa1098 [1098-T Tax Information 1 [cusupar ‘

|FrM]TYP |1E|99 Income Type Cods Maintenance
FAAL099 |1093 Reporting
FOALD99 |1099-MISC Magnetic Tape Transmitter D.

PXA1099 [1099-R A | ‘
PTW1099 |1099-R Distribution Code Validation | ‘

If you know the object’s
name, enter the object

name in a blank Name ——
field and press Enter.

To query objects and add to My Banner:

Use these steps to reduce the list of object names in the left pane. You can add any or all of
the matches to My Banner.

1. Access the My Banner Maintenance Form (GUAPMNU).
2. Use the pull-down list above the left pane to select the object type you want to query.
3. Place the cursor in the left pane.
4. Select the Enter Query function. The object list disappears.
5. Enter the search criteria.
You can use the Oracle wildcards % and _. Capitalization matters. Data is matched
against the search criteria exactly as you enter them.
6. Select the Execute Query function. The left pane lists the matching objects.
7. To add all matches to the menu (if there are 20 matches or less), click in the right
pane where you want to place the new menu items. Then click the Insert All button
in the middle of the form E
OR
To add selected matches to the menu, select the objects in the left pane by double-
clicking each one. Click in the right pane where you want to place the new menu
items. Then click the Insert Selection button in the middle of the form E
8. Save.
|
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Select the object type
you want to query.

Place the cursor
in the left pane.

Select Enter

Enter the search

Select Execute

The form displays
all matching

To select individual
objects:
Select the objects, click in

%8 My Banner Maintenance GUAPMNU

JPIERSOL's Personal Menu

[axas] [

"5_9 My Banner Maintenance GUAPMNU

JPIERSOL's Personal Menu

————————Fype: |FORM e @ Object Description
[cEaaTTD [Attendance =)
Object Description
) B [aL1apPL |application Inquiry

Object Description

GXADIRD| ‘Dirar:t Deposit Recipient

|G><ATP]D ‘ED] Trading Partner Identification

the right pane, and click this

To select all objects
(20 or less):
Click in the right pane, and

click this button.

Objects appear on
your My Banner

menu.

(2] [

(&) 7

Object Description
[cEaaTTD [attendance (=)
[aL1apPL [application Inquiry

Object Description
[attendance e
|sxapRD |Di_rect Deposit Recipient
GXATPID EDI Trading Partrier Identification
GLIAPPL Application Ingquiry

To delete selected objects from My Banner:

1. Access the My Banner Maintenance Form (GUAPMNU).

2. Inthe right pane, select each object you want to delete by double-clicking it. When
you select an object, the name is highlighted.

3. Click the Remove Selection button in the middle of the form ﬂ The selected
objects are deleted.

4. Save.
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JPIERSOL's Personal Menu

Object Description

[rsa1098 [1098-T Tax Infarmation &

[FrvITye (1099 Income Type Code Maintenance
[Faa1093 (1099 Reporting

[Foa1099 [1099-MISC Magnetic Tape Transmitter D.
[Pitaioos [tooar
[PTu1099 | [1099-R Distribution Code validation

[ruAova1 [2000-2001 Applicant Override th =]
[RNRGLOL [2000-2001 TNAS Global Palicy Options R. «
[RuIMs01 | [2000-2001 Miscellangous Results Inguiry

[RuANADL [2000-2001 Need Analysis ]
[RnavRo1 |[2000-2001 Need Analysis Document veri = [

[rraPRO1 [2000-2001 Heed Analysis Processing

Object Description
[cERaTTD [attendance
[sxap1rD [Direct Deposit Recipient _ Select each object
[zxatPiD [EDI Trading Partner Identification you want to delete

(GLIAPP [application Inquiry

from the menu.

Click this button.

To delete all objects from My Banner:

1. Access the My Banner Maintenance Form (GUAPMNU).

2. Click the Remove All button in the middle of the form ﬁ|

3. Save.

JPIERSOL's Personal Menu

Object Description

[reat09s [1098-T Tax Information

|FI'MITYP {1[@9 Income Type Code Maintenance

|Fas109a 1039 Reparting

|FOA1IJQQ ‘1D99-MISC Magnetic Tape Transmitter D.

|patoss [1093-R

[PTv1099 [1099-R Distribtion Code validation

|rHacu01 [2000-2001 Applicant Override

Object

EE

Description

‘Attendance

[suaaeoT

‘About SCT Banner

|SSAQCRL

[academic Calendar Rule Query

[sTvaceL

[Academic Calendar Type Validation

|GLIAPPL

[application Inquiry

[ruRGLO1 [2000-2001 &S Global Policy Optians RL
|RNIMSDI 12000-2001 Miscellaneous Results Inguiry

[rManA0L [2000-2001 Heed Analysis

|RNAVRD1 ‘ZDDD-ZDDI Need Analysis Document Veri =7
|rMaPRO1 [2000-2001 Need Analysis Processing

@r@ (&l @

Click this button to
delete all menu items.

To change the location of an object in My Banner:

1.

Access the My Banner Maintenance Form (GUAPMNU).

Delete the object from the menu (see the instructions on 5-5).

Add the object to the menu in its new location (see the instructions on 5-3).

Select the Save function.
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To customize a lower level menu on My Banner:

1. Access the My Banner Maintenance Form (GUAPMNU).

2. Select the menu in the right pane by double-clicking it.

3. Perform a Next Block function. Contents of the menu appear in a new window.

4. Use the normal techniques to add to, change, and delete from the menu.

5. Save.

JPIERSOL's Personal Menu

Description

[atrendance
Object Description
] P STO |Academic History Process Control SEIeCt the menu.
[rsa1098 [1098-T Tax Infarmation = [cuanBOT [ebout scT B
ou anner
[Frarree [1099 tncome Type Code Maintenance [ssaachL [academic Calendar Rule Query
FaA1099 [1099 Reporti
[ [ eporting [sTvaccL [academic calendar Type ualidation
[Fos109s [1099-m15C Mannetic Tape Transmitter D | (eLiapeL [application trauiry Perform a Next Block
[p%a1099 [1099-r = ‘ [ function

[Prv1099 [1099-R Distribution Code validation

[rrRGLOL [2000-2001 1MAS Global Policy Options Ry

|RNAOVD1 |2EIEIIJ-2IJI31 Applicant Override @ } I
\ |

=

|RNIMSE|1 |2EIEIU-2EIUI Miscellaneous Results Inquiry

JPIERSOL's Personal Menu \ Academic History Process Control
Object Description
Type: [FORM | [@
@ ey e

Object Description Object Description
[rsa1008 [1098-T Tax Infarmation = [sHacRDE [Grade Code Maintenance
|FFMITYP |1E|99 Incame Type Code Maintenance |SHAGRDS |Grade Substitution Maintenance
[Faa1093 [1009 Reporting [sHasceT [academic Standing Rules Contents of the menu
|F0A1n99 |1D99—M15c Magnetic Tape Transmitter D, |5H’“GCOL |G"ade Mailer Status/Error Correction appear in a new window.
[razoss [rose . [sHarPTR [repeatMuliple Course Rules Use normal techniques to

= : : SOACTRM Continuant Terms Rula
[Prv1099 [1099-r Distribution Code validation : |5HACTRL |n ; T add to, change, and
[rrAovoL [2000-z001 Applicant Override s [ |academic History Control
& [sHaceDI [EDI Academic Grade qualifier delete from the menu.

[ruRGLOL [2000-2001 TMAS Global Paliey Options RU B
|RNIM501 |ZDDD-2001 Miscellansous Results Inquiry |SHAGRUL |Grade Book Rule Definition
[ruansDL [2000-2001 Heed Analysis =] [sHarTve [rule Type Definition
|RNAVRD1 |2DDD—2DD1 Meed Analysis Document veri @ |5H’“RP’°‘R |G"ade Book Rule Parameter Definition
[ruaPROL [2000-2001 Meed analysis Processing [sHacPaR [ePa Display Rules
[rrasLoL [z000-2001 Student Loan Data [curriculum Rules and Cantral
[ruasuor [2000-z001 Supplemental Need Analysis |

To copy a My Banner:
1. Access the My Banner Maintenance and Copy Form (GUTPMNU).

2. Use the User pull-down list to select the My Banner you want to copy. The selected
My Banner appears in the right pane.

3. (Optional) Use the normal techniques to add to, change, and delete from the menu
before it is copied. If you want to change the original menu, select the Save function.
If you want the changes to affect the copies only, do not select the Save function.

4. Click the Display Users button. A list of IDs appears.
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Click the Copy button in the middle of the form. A list of user IDs appears in the left
pane.

(Optional) To reduce the list of 1Ds, enter a partial ID in the field above the left pane.
Start with the first character and enter as many characters as you know. Press Enter.

Select each user ID to receive the copied menu by double-clicking it. When an ID is
selected, it is highlighted.

Click the Copy to User(s) button.
If any of the IDs already has a My Banner, a dialog box asks if you want to overwrite
existing My Banners.

« To overwrite all selected My Banners, click the Yes button.

« To review each ID before deciding, choose the No button. A dialog box
appears for each ID that already has a My Banner. Choose Yes to overwrite
the old menu, or No to keep the old menu for the ID.

When the menus are copied, a message tells you how many menus were copied
successfully.

June 2008



s [GioRRES = Select the My Banner
7 ipti ou want to copy.
Type: [Farm = @ Object Description Y py
advancement Individual Summary
Object Description
] L ADADESG Designation
TEAL09E ||[1098-T Tax Informat =
2 fnfarmesen AMAINFO Advancement Prospect Information
FTMITYP | [1099 Income Type Code Maintenance e i Contents of the My Banner
(LSRR |0 R ] AGCeIrT e List appear in the right pane.
FOAL099 |[1099-MISC Magnetic Tape Transmittsr D. AN T oo
PHALDSS | [L099-R & - 2
55 APACONS Advancement Individual Information Add t h d d I
PTY1099 |[1099-R Distribution Code validati i 0, change, an elete
Al S & [aonorGN [advancement Organization Header ’ 9 !
RMADYD1 | |2000-2001 Applicant Override =] ‘ ‘ fromthe menu, if necessary,
RNRGLO1 |[2000-2001 INAS Global Policy Options RU @ before copying.
RNIMS0L |[2000-2001 Miscellaneous Results Inquiry
RMANADL [2000-2001 Meed Analysis EE]
RNAVRO1 |[2000-2001 Heed Analysis Document Yeri = [
RNAPRO1 |[2000-2001 Need Analysis P P :
peseoe e | [l Click this button.
RNASLOL |[2000-2001 Student Loan Data =]
RMASUDL |[2000-2001 Supplemental Ngs . TR
RNAOWOZ2 [2001-2002 Applicant Overr — =
User: [cNORRIS -]
RNRGLO2 |[2001-2002 INAS Global Pol
Search: | Object Description
[apasBIO Advancement Individual Summary
. User Name User ID
A ||St Of user IDs ADADESG Designation
GRS 25 al AMAINFO Advancement Prospect Information
appears in the ALUMNI_USER 222 R Plodos it
ALUWEB_TRACE 246 o
left pane. = - AGCGIFT Gift List
AMACDONA 181 .
APAIDEN Advancement Identification
SLii & APACONS Advancement Individual Information
APITCHAL 135 -
ACAORGN Advancement Organization Header
APOLISKI 104 " ‘
APPWORR 453
(<1
40 313
AQADM 316 ]
AQUSER 317 @
AROLLAG 371
ARSTS_TRACE 244 &
ARSTS_USER 216 &
374 B
ASOROKA 262
AYELURI
BotCONEILE User: |CNORR[S o
. _ Object Description
If you want to reduce the list of Search: [?
// APASBIO Advancement Individual Surmmary
User Name User ID
IDs, enter search characters TR oo nation
and press Enter. RatLoo Le2 W AMAINFO Advancement Prospect Information
SHENNESS el AGCPLDG Fledgs List
RKEVITCH 260
Select each user ID to T . AGCTIHT i it
. . 4PAIDEN Advancement Identification
receive the copied menu.
p RHAHIMAT e AFACONS dvancement Individual Information
ROMGYER 337
AOAORGH Advancement Organization Header
RPEREZ 205 E
RROBINSO 375 1@
RROTHERM 190 |
RRULLO 331 o e
RVENKATE 136 < =
RWISSERT 290
. . RZELLEFR 124 @ | |
Click this button. i : @ I I
\ \ B
‘ ‘ | |

Title Bar Display Options

You can choose to display any or all of the following in title bars:
* Form names
* Release numbers

» Database instances
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To select information for your title bars:
1. Access the General User Preferences Maintenance Form (GUAUPREF).
2. Click the Form Display Options button.

3. Select or clear the display options, depending on the information you want to see on
your form title bars.

4. Select the OK button. A dialog box says you must exit and restart Banner to see the
changes.

5. Select the OK button in the dialog box.
6. Exit Banner.

7. Restart Banner to see your changes.

Displayed Form Names

You can choose whether form names are displayed in the following places:
» Options pull-down menu
* Left pane of menu maintenance forms

* List of open windows on the Window pull-down menu

To display or hide form names:
1. Access the General User Preferences Maintenance Form (GUAUPRF).
2. Choose the Display Options tab.

3. Check the Display Form Name on Title Bar check box to display the form name, or
clear the check box to hide it.

4. Save.

5. Exit the form.

> Note
A change to this display option, as well as to the release number or
database instance, occurs immediately. You do not need to exit Banner.
However, if you change any other display options, you must exit and
restart Banner to see the changes. [
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Customizing the Main Menu

June 2008

You can customize the Banner main menu in several ways:

» Specify the default expanded menu that appears when you log in

» Create My Links for frequently used Banner objects or external web sites

5 Note
Changes to Banner colors will not appear on the main menu until you log

out and log back in.

Default Expanded Menu

The Banner main menu appears when you first access Banner. You can change the default
product menu that is expanded to suit your personal preference.

To specify the default expanded menu:

Access the General User Preference Maintenance Form (GUAUPRF).

In the User Default field, enter the name of the menu that you want as the default, or

click the Search button to search for it using the Object Search Form (GUIOBJS).

1.

2. Choose the Menu Options tab.
3.

4. Save your changes.

My Links

You can create a link from the main menu to a web site or Banner object using Personal

Links. Make sure you do not have pop-ups blocked with any third-party software. Pop-up
blockers can interfere with the performance of your personal links.

To create a link:

Go to the General User Preferences Maintenance Form (GUAUPRF).

Choose the My Links tab.

Enter a description of your link in the User Value field associated with the first

personal link description.

Enter the URL or Banner object name in the User Value field associated with the first

personal link URL or Banner object.

Banner General 8.0
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5. Save. You must exit Banner and log back in to see your changes.

> Note
You can create up to six personal links. Each personal link is comprised of
two records—the description and the URL/object. Make sure the
description record matches the corresponding URL or Banner object
record. The following example illustrates a personal link for a weather

web site. m
Field Name Name of Your Link URL or Banner object
Description Enter the description for the “My  Enter the URL or Banner object
Personal Link 1" link. for the “My Personal Link 1” link.
Default Value  Your first personal link Your first personal link URL or
description Banner object
User Value My weather page www.weather.com

Changing Your Alerts

Alert options enable you to customize how you are prompted by Banner in certain
situations. Access the Display Options tab on GUAUPREF to customize any of the
following:

» Check the Prompt Before Exiting Banner check box if you want Banner to verify
that you want to quit the Banner session before exiting.

» Check the Display Additional Confidential Alert check box if you want Banner
to display an extra Confidential pop-up message for records that contain
confidential information.

» Check the Display Additional Deceased Alert check box if you want Banner to
display an extra Deceased message for records associated with a deceased person.

Changing Your Banner Password

The Change Banner Password link goes to the Oracle Password Change Form
(GUAPSWD), where you can change your password.

Changing Your Banner Colors

You can customize your colors for Banner via the General User Preferences Maintenance
Form (GUAUPREF). Custom colors can be specified at the site level, by logging in as the
baseline user and changing the values in the Default Value fields, and also at the
individual user level, by changing the values in the User Value fields.
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You can customize the color of the following items:
 Buttons, such as Cancel and OK (buttons in the toolbar are not included).
 Canvas of all forms
* Record highlighting
« Scroll and separator bars
» Code/Description prompts

 Canvases within the main menu, including the broadcast message, menu, and menu
tree canvases

To change the color of an item at the user level:

1. Go to User Interface Color Settings on the Display Options tab.

2. Inthe User Value field for the item you want to change, choose a color.
s Note

You can select a pre-defined color from the palette, or create your own
shade by using HSB (Hue Saturation Brightness) or RGB (Red Green

Blue) values. [
3. Select OK.
4. Save.
5 Note

SunGard Higher Education delivers the default values as seed data. If
you change the default colors as the BASELINE user, all users who have
not entered the GUAUPREF form at the individual user level will see the
baseline colors you selected. [

Optimal Screen Resolution

Standard screen resolution of 1024x768 allows ample room for displaying user interface
components in Banner.

If you have the Display Properties>Appearance of your workstation set to Windows XP
style, you may see horizontal or vertical Windows scrollbars. If you want to eliminate the
scrollbars, you can use any of the following techniques:

» On the workstation, set the Display Properties>Appearance to Windows Classic
style.

» On the workstation, leave the display properties as Windows XP style, but go to
Display Properties>Settings>Advanced and choose a Custom DPI setting of 95
DPI, which is 99% of the normal size.
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» On the workstation, leave the display properties as Windows XP style, but go to
Display Properties>Settings>Advanced, select the Active Title Bar item from the
Item pull-down list, and enter a value of 18 in the corresponding Size field. Enter a
value of 8 in the Size field for the font.

» Use the Windows XP style on the workstation, but have your site administrator
establish a Banner URL configuration that sets the client DPI value to 95. This
method eliminates the need for users to change their individual workstation
settings.
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6 Tips and Tricks

n

This section contains some of SunGard Higher Education consultants’ favorite tips for
using Banner and teaching new users about it. A few of the tips that appear in this chapter
are also described in more detail elsewhere in the handbook.

Shortcuts for Entering Information

Topic

Tip /Trick

System date

Dates within the
current month

Dates within the
current year

Populating
records on
forms

In most date fields, entering a single, non-numeric character followed
by Enter or Tab will display the current date. It’s easy to remember T
for Today, or S for System Date. Even special characters work for this
shortcut. Forget what today’s date is? Enter a question mark and
Banner will tell you.

If you enter a two-digit number in a date field, Banner assumes the
current month and year. For example, if the month is May and the year
2005, 10-MAY-2005 has the shortcut 10.

If you enter a four-digit number in a date field, Banner assumes the
current year. For example, if the year is 2005, 15-JUN-2005 has the
shortcut 0615.

After entering the SSN, click in the first enterable field, and the record
will be populated.

Note: This shortcut works for about 80% of forms. Remember that you
proceed out of the key block by performing a Next Block function.

Navigation Shortcuts from the Main Menu

Topic

Tip /Trick

Shortcuts in the
Go To field

Enter SITE to navigate to the site map.

Enter TREE to navigate from the site map to the product tree.
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Topic

Tip /Trick

Enter REFRESH to:

» Refresh your personal menu (My Banner) after making
changes on GUAUPRF

* Return to the Banner menu even if you are buried deep
inside other menus

 Refresh the site map

Press the up or down arrow keys to navigate to any of the last 10 forms
you accessed.

Enter the menu name to expand that menu.
Example: *GENJOB
Expands the General JOBSUB directory.

Enter EXIT to end your Banner session.

Enter the Quickflow name to automatically open the first form in the
Quickflow.

Enter a job name and GJACPTL will open and run it.
Enter *PERSONAL to open the My Banner menu.

Enter *MENU to open the Banner menu no matter where you are.

Other Navigation Shortcuts

Topic Tip /Trick

Rollback The Rollback function clears out the record and takes you back to the
key block, so you can take another snapshot from the database or enter
another ID number.

Shortcut to Double-clicking in a number or date field will display the calculator or

calendar or calendar, respectively.

calculator

Banner General 8.0
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Queries

Topic Tip /Trick

Enter/exitquery You must always perform an Enter Query function before performing
sequence an Execute Query function. Even if the form is blank when you access
it, you must ensure it is in Enter Query mode.

Re-executing a  If you have not selected a record after your query, and wish to execute
query another, you can perform two Enter Query functions in a row, and
Banner will retrieve the last set of query criteria you executed.

Wildcards The character _ represents a single character in your query, while the
character % represents any number of continuous characters.

Logging In/Out

Topic Tip /Trick
Enter login When logging in, you can enter the username and password all on one
information all line.
on one line
For example:

Username: rsmith/yourpassword
instead of
Username: rsmith

Password: yourpassword

3 Note
If you enter your password in the Username field
along with your name, your password will be
visible. =

Enter EXITto  Enter EXIT in the Go To field on the main menu to end your Banner
quit Banner session.

Eliminate extra  Clear the Prompt Before Exiting Banner check box on the Display
prompt before  Options tab of GUAUPRF to eliminate the extra message that verifies
exiting whether you want to quit prior to ending your Banner session.
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Error Messages

Topic Tip /Trick
GUAERRM If the Banner Error Messages Form (GUAERRM) appears, then the
appears error resulted from an API. This information can be helpful when

trying to resolve the error with your system administrator.

Miscellaneous

Topic Tip /Trick

Names are Names in the Name fields on Banner forms may be formatted
formatted differently across Banner products. This is due to different functional
differently areas at your institution having different needs for displaying and
across Banner  \yorking with name data.

products

Quick and easy

Go from a Banner form to a pie chart in four mouse clicks. From the

pie chart Help pull-down menu on the main menu, choose the Extract Data No
Key option to create a .csv file that can be opened and formatted using
a spreadsheet program.
Not all forms have a data extract option. Query the Data Extract
Option field on GUAOBJS to determine the forms for which it is
available.
Best You will generally find the best information about new functionality in
information the release guide where it was first introduced, or when available, in a
about new

functionality

handbook specific to a topic (especially when it involves multiple
product areas).

Ask your IT department for the latest release guides when they are
available.
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A

C

address, format of 3-26
alert box 2-3, 2-30
application forms 2-7
Approve button 2-29
auto hint 2-26, 4-15

B

Banner
customizing 5-1
entering information 3-11
exiting 2-37
help 4-3
messaging 4-18
naming conventions 1-5
Oracle functions used with 2-36
guerying information 3-28
see Banner
starting 1-1
Banner Dynamic Help
see Dynamic Help
block
definition of 2-25
key block 2-25
title of 2-25
Block menu 2-17
blue field names 3-11
Bookshelf
see Banner Documentation Bookshelf
buttons
iconic 2-28
on toolbars 2-23
radio 2-31
response 2-30
toolbar 2-23
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Calculate button 2-29
calculator 4-2
calendar 4-1
Calendar button 2-28
Cancel function 2-36
Cancel Query function 3-29
century in queries 3-45
changing Banner colors
main menu 5-12
changing Banner password
main menu 5-12
changing your alerts
preferences 5-12
check box
querying 3-30
use of 2-31
checkbox
clearing 2-31
selecting 2-31
Clear Form function
see Rollback function
code/description lookup 3-11
column 2-34
Comments button 2-29
Commit function
see Save function
Complete button 2-29
control forms 2-10
Copy button 2-29
Count Hits function
see Count Query Hits function
Count Query Hits function 2-36, 3-29
customizing Banner
expanded menu 5-1
form names in navigation frame 5-10
main menu 5-11
My Banner 5-1
Options menu 5-10

Banner General 8.0 -1
Banner Getting Started Guide
Index



title bar 5-10

D

Data button 2-28
Data Extract
changing default directory for extract files
3-50
data format
addresses 3-26
dates 3-26
IDs 3-25
names 3-25
dates
century in queries 3-45
format of 3-26
in Job Submission 3-27
in queries 3-27, 3-45
on reports 3-27
time stamp 3-45
description lookup 3-11
Detail button 2-28
dialog box 2-3, 2-30
Direct Access 1-2, 3-2
disabled field 2-33
Disapprove button 2-29
Display Navigation Window key 3-10
display only field 2-33
Documentation Bookshelf
accessing a manual 4-13
indexes 4-13
searching 4-14
Down function 2-36
drill-down search 3-15
Dynamic Help
accessing in edit mode 4-8
accessing in query mode 4-8
creating 4-10
description of 4-7
Local Dynamic Help 4-7
replacing 4-11
searching 4-11
updating 4-10

E

Edit function 2-36
Edit menu 2-17
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editor
copying text 4-16
cutting text 4-17
deleting text 4-17
description of 4-15
expanding a field 4-16
inserting text 4-16
pasting text 4-17
replacing text 4-16, 4-17
searching text 4-17
selecting text 4-16
enabled field 2-33
Enter Query function 2-36, 3-28
enterable field 2-33
entering information
format recommendations 3-25
from another form 3-16
ID 3-17
in validated fields 3-11
new record 3-24
with a Search button 3-16
Execute Query function 2-36, 3-28
Exit function 2-37
Exit Query function 3-29
Exit with Value function 2-37
Exit without Value function
see Exit function
exiting Banner 2-37
extended query 3-32

F

Fetch Next Set function 3-29
fields
accessing 2-34
description of 2-33
disabled 2-33
display only 2-33
enabled 2-33
enterable 2-33
File menu 2-15, 3-10
format
addresses 3-26
dates 3-26
IDs 3-25
names 3-25
forms
application 2-7
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control 2-10

definition of 2-1

elements on 2-27

GJIREVO Saved Output Review Form 3-
46

GUAHELP Help Form 4-7

GUAPMNU My Banner Maintenance
Form 5-1

GUAUPREF General User Preferences
Maintenance Form 3-50

GUIALTI SSN/SIN/TFN Alternate 1D
Search Form 3-21

GUTPMNU My Banner Maintenance and
Copy Form 5-1

inquiry 2-12

main menu 2-5

naming conventions 1-5

parts of 2-14

query 2-11

rule 2-9

types of 2-4

validation 2-8

wizard 2-13

G

General User Preferences Maintenance
Form (GUAUPRF) 3-50

Generate ID button 2-29

GJIREVO Saved Output Review Form 3-46

GUAHELP Help Form 4-7

GUAPMNU My Banner Maintenance Form 5-
1

GUAUPRF General User Preferences
Maintenance Form 3-50

GUIALTI SSN/SIN/TEN Alternate ID Search
Form 3-21

GUTPMNU My Banner Maintenance and
Copy Form 5-1

H

help
auto hint 2-26, 4-15
Dynamic Help 4-7
Help (Item Properties) 4-15
online help 4-3
Show Keys 4-15

Help (Item Properties) 4-15
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Help Form (GUAHELP) 4-7
Help function 2-37

Help menu 2-20

horizontal scroll bar 2-2, 2-32

iconic buttons
Approve 2-29
Calculate 2-29
Calendar 2-28
Comments 2-29
Complete 2-29
Copy 2-29
Data 2-28
Detail 2-28
Disapprove 2-29
Generate ID 2-29
In Process 2-29
Maintenance 2-29
navigating with 3-8
No Data 2-28
on toolbars 2-24
Search 2-28
selecting 2-30, 3-8
Summary 2-28
within forms 2-28

entering 3-17, 3-18
format of 3-25
Oracle Soundex search 3-23
searching for 3-18, 3-23
selecting 3-20
ID search forms 3-20, 3-23
ID/name search
accessing a search form 3-20
entering IDs 3-18
entering names 3-18
reducing a search 3-20
searching for IDs 3-18
searching for names 3-19
selecting an ID 3-20
identification number. See ID
In Process button 2-29
inquiry forms 2-12
item 2-33
I[tem menu 2-18
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Job Submission
dates 3-27
Job Submission forms
Saved Output Review Form (GJIREVO)
3-46
jobs, naming conventions 1-5

K

| |
key block 2-25

keyboard usage 1-2, 1-3, 3-8
Keys list 1-3, 2-39, 4-15

L

Last Criteria function 3-28
links
main menu links 2-24
List function 2-37
List of Values
defining 3-11
displaying 3-13
drill-down search 3-15
refining a search 3-14
selecting Dynamic Help 4-9
use of 2-8, 3-11
Local Dynamic Help 4-7
LOV. See List of Values

M

main menu
accessing 1-1
changing Banner colors 5-12
changing Banner password 5-12
customizing 5-11
description of 2-5
format of 2-5
left pane 3-2
My Banner 2-6
navigation 3-2
right pane 3-2
main window, definition of 2-1
Maintenance button 2-29
menu bar 2-14
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menus
accessing a main menu item 3-2
accessing a menu bar item 2-15
Block menu 2-17
customizing 2-6, 5-1
Edit menu 2-17
expanding 3-2
File menu 2-15
Help menu 2-20
I[tem menu 2-18
menu bar 2-14
Options menu 2-17, 3-5, 5-10
Query menu 2-19
Record menu 2-18
Tools menu 2-19
messages 4-18
mouse usage 1-2, 3-8
My Banner
adding objects 5-2, 5-3
copying 5-7
deleting objects 5-5, 5-6
description of 2-6
lower level menus 5-7
guerying objects 5-4
reordering objects 5-6
My Banner Maintenance and Copy Form
(GUTPMNU) 5-1
My Banner Maintenance Form (GUAPMNU)
5-1

N

name
entering 3-18
format of 3-25
searching for 3-19
naming conventions 1-5
navigation
Direct Access 3-2
Display Navigation Window key 3-10
File menu 3-10
iconic buttons 3-8
keyboard equivalents 3-8
main menu 3-2
mouse 3-8
Object Search 3-3
option window 3-6
Options menu 3-5
QuickFlow 3-9
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site map 3-4

Tabs 3-4
navigation frame 5-10
new records 3-24
Next Block function 2-37
Next Field function 2-37
Next Item function

see Next Field function
Next Primary Key function

see Exit with Value function
Next Record function 2-37
No Data button 2-28
non-person IDs 3-25

@)

Object Search 3-3
online help 4-4
Option List 2-28, 3-13
option window
navigating with 3-6
selecting 3-6
Options menu 2-17, 3-5, 5-10
Oracle functions used with Banner 2-36
Oracle Soundex search 3-23
Oracle wildcards 3-31

P

password 1-1
person IDs 3-25
postal code, format of 3-26
pound sign 3-26
preferences

changing your alerts 5-12
Previous Block function 2-38
Previous Field function 2-38
Previous Item function

see Previous Field function
Previous Record function 2-38
pull-down list 2-35

Q

gueries
century in dates 3-45
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counting hits 3-31
dates 3-27, 3-45
definition of 3-28
extended query 3-32
Oracle functions 3-28
querying information 3-29
time stamp 3-45
wildcards 3-31

query forms 2-11

Query menu 2-19

QuickFlow
navigational tool 3-9

R
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radio button 2-32
record
count 2-27
description of 2-34
inserting 3-24
Record menu 2-18
reports and processes
naming conventions 1-5
printing online output 3-46
saving online output 3-46
viewing online output 3-46
response button 2-30
Rollback function 2-38
row 2-34
rule forms 2-9

S

sample forms
application form 2-7
control form 2-10
inquiry form 2-12
main menu 2-5
query form 2-11
rule form 2-9
validation form 2-8
wizard form 2-12
Save function 2-38
Saved Output Review Form (GJIREVO) 3-46
scroll bars
horizontal 2-2, 2-34
use of 2-32
vertical 2-32, 2-34
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Scroll Down function 2-38
Scroll Up function 2-38
Search button 2-28
Select function
see Exit with Value function
Show Keys function 1-3, 2-39, 4-15
site map 3-4
Soundex search 3-23
SSN/SIN/TFEN Alternate ID Search Form
(GUIALTI) 3-21
starting Banner 1-1
status line, contents of 2-27
Summary button 2-28
System Functions/Administration forms
General User Preferences Maintenance
Form (GUAUPRF) 3-50
Help Form (GUAHELP) 4-7
My Banner Maintenance and Copy Form
(GUTPMNU) 5-1
My Banner Maintenance Form
(GUAPMNU) 5-1
SSN/SIN/TEN Alternate ID Search Form
(GUIALTI) 3-21

T

U

Up function 2-39
user ID 1-1
username 1-1

Vv

validation forms
use of 2-8, 3-11
vertical scroll bar 2-32

W

wildcards 3-31
window pane 2-2
windows
alert box 2-3
definition of 2-1
dialog box 2-3
pane 2-2
wizard forms 2-13

Z

tables, naming conventions 1-5
Tabs 3-4
text
copying 4-16
cutting 4-17
deleting 4-17
inserting 4-16
pasting 4-17
replacing 4-16, 4-17
searching 4-17
selecting 4-16
time stamp 3-45
title bar
contents of 2-24
customizing 5-10
toolbar
accessing 2-23
description of 2-23
horizontal 2-24
Tools menu 2-19
types of forms 2-4
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